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A PROPOS DE CE COURS  
PRÉREQUIS DU COURS  

Ce manuel suppose que l'utilisateur a terminé ou comprend le matériel couvert dans la 
deuxième partie du didacticiel Microsoft Office Excel 2016, notamment:  
▪ Création de formules avancées  
▪ Analyser des données avec des fonctions logiques et de Lookup  
▪ Organisation des données de la feuille de calcul avec des tableaux  
▪ Visualiser des données avec des graphiques 
▪ Analyse de données avec des Pivot Tables, slicers, et Pivot Charts  
▪ Insérer des graphiques  
▪ Améliorer les classeurs 

 

APERÇU DU COURS  

Bienvenue dans la troisième partie de notre didacticiel Microsoft Office Excel 2016. Cette 
version d'Excel intègre de nouvelles fonctionnalités et options de connectivité afin de simplifier 
au maximum la collaboration et la production. 
 
Ce cours est destiné à aider tous les utilisateurs à se familiariser avec les différents aspects 
d'Excel, y compris certaines de ses fonctionnalités les plus avancées. Nous verrons comment 
automatiser les fonctionnalités des feuilles de travail, vérifier les feuilles de travail, analyser les 
données, utiliser plusieurs classeurs et exporter des données Excel. 
 

OBJECTIFS DU COURS  

À la fin de ce cours, les utilisateurs doivent être à l'aise avec l'automatisation des 
fonctionnalités des feuilles de calcul, l'audit des feuilles de calcul, l'utilisation de divers outils 
d'analyse, l'utilisation efficace de plusieurs classeurs et l'exportation de données Excel. 
 

COMMENT UTILISER CE LIVRE  

Ce cours est divisé en six sections. Chaque section est centrée sur plusieurs sujets clés, chacun 
étant divisé en concepts faciles à suivre. À la fin de chaque sujet, vous aurez une activité à 
compléter. À la fin de chaque section, nous résumerons ce qui a été couvert et vous fournirons 
quelques questions de révision auxquelles vous pourrez répondre. Un complément 
d’apprentissage pour certains sujets est fourni sous la forme de Section Labs à la fin de ce livre. 
Avant de commencer, téléchargez les fichiers d’exercices du cours dans un endroit pratique. Ils 
seront référencés tout au long de ce cours et constituent un élément clé de votre expérience 
d’apprentissage.   



Excel 2016 Niveau 3 (Avancé)         2 

training@compuease.ca www.compuease.ca 613-235-6161 

SECTION 1:  
AUTOMATISATION DES 

FONCTIONNALITÉS DES FEUILLES 

DE CALCUL 
 
 

Objectijs de la section 

 

Dans cette section, vous apprendrez comment:  

▪ Mettre à jour les propriétés du classeur  

▪ Créer et éditer une macro  

▪ Appliquer une formatage conditionnelle  

▪ Ajouter des critères de validation de données à un classeur 
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SUJET A: Mettre à jour les propriétés du 
classeur 
 
Dans Excel 2016, vous pouvez afficher, ajouter ou même modifier les propriétés d'un classeur 
existant. Ces propriétés peuvent inclure des informations telles que l'auteur du classeur, les 
informations de date, etc. Ces informations de type sont appelées métadonnées et peuvent 
s'avérer très utiles lors de la gestion de plusieurs classeurs. Au cours de cette rubrique, vous 
apprendrez tout sur les propriétés des classeurs et sur la façon de les utiliser. 
 

OBJECTIFS DU SUJET  

Dans ce sujet, vous apprendrez:  

• A propos des propriétés du classeur 
 

PROPRIÉTÉS DU CLASSEUR  

Vous pouvez afficher les propriétés de votre classeur à partir d’Excel en cliquant sur File → Info 
→ Properties → Advanced Properties: 
 

 
 
Lorsque la boîte de dialogue workbook Properties s'ouvre, vous verrez qu'elle contient cinq 
onglets: General, Summary, Statistics, Contents, et Custom. 
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L'onglet General  affiche des informations de base sur le classeur en cours, notamment le nom 
du fichier, son type et sa taille. En outre, cet onglet affiche le nom MS-DOS du classeur en cours, 
ainsi que le moment de sa création, de sa modification et de son dernier accès:: 

 
L'onglet Summary permet d'afficher, de modifier ou d'ajouter des informations sur les auteurs 
et les mots clés concernant le fichier en cours. Plus précisément, vous pouvez ajouter des 
informations sur le titre, le sujet, l'auteur, le responsable et la société aux propriétés du fichier. 
Vous pouvez également ajouter des informations sur les catégories, ainsi que des mots-clés et 
des commentaires, pour vous aider à identifier et classer ce fichier:  
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L'onglet Statistics affiche la date de création du fichier actuel, sa dernière modification, son 
dernier accès et même sa dernière impression. Vous pourrez également déterminer quand le 
fichier actuel a été sauvegardé pour la dernière fois, combien de fois il a été révisé et combien 
de temps il a été ouvert pour édition:  

 
(Comme pour l'onglet General, les données ici sont générées par votre ordinateur et ne 
peuvent être ni modifiées ni supprimées.) 
L'onglet Contents affiche le nombre de feuilles de calcul contenues dans le classeur actuel et 
leur nom:  
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(Comme la plupart des autres onglets de cette boîte de dialogue, les données de cet onglet ne 
peuvent pas être modifiées.) 
 
Enfin, l'onglet Custom vous permet d'ajouter des informations personnalisées au fichier. Par 
exemple, vous pouvez ajouter des attributs tels que l'objectif du fichier ou le nom du 
département de votre organisation qui l'a créé: 

 
 
N'oubliez pas que toutes les données ajoutées ici ne seront affichées que dans l'onglet Custom 
de la boîte de dialogue Propriétés.   
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SUJET B: Créer et éditer une macro 
 
En raison de la nature d'Excel et de son utilisation, vous risquez souvent de devoir répéter la 
même tâche encore et encore. Pour vous aider à rationaliser votre flux de travail, il est possible 
d'automatiser ces tâches en créant une macro. Les macros sont créées à l'aide de code dans 
Visual Basic pour Applications; Cependant, vous n'avez pas besoin de connaître la 
programmation pour créer une macro. Au cours de cette sujet, vous apprendrez à créer une 
macro à l'aide de l'enregistreur de macros. 
 
Objectifs du sujet  

Dans ce sujet, vous apprendrez:  
▪ À propos des macros  
▪ À propos de la boîte de dialogue Record macro  
▪ À propos du nommage des macros  
▪ À propos de Visual Basic pour applications (VBA)  
▪ Comment copier des macros entre des classeurs 
▪ Comment configurer les paramètres de sécurité des macros 

 

LES MACROS 

Les macros sont de petits programmes créés pour exécuter une tâche spécifique ou un 
ensemble de tâches. Ils sont créés soit en vous enregistrant en complétant cette tâche, soit en 
codant une macro la complétant directement dans VBA. Dans les deux cas, une fois la macro 
terminée, vous pouvez la lier à un bouton personnalisé ou à une touche de raccourci pour 
l'exécuter à partir de la fenêtre de l'application pour laquelle vous créez la macro. 
 
Par exemple, vous pouvez créer une macro qui protégera une feuille de calcul à l’aide de 
paramètres prédéterminés. Cela vous éviterait de creuser dans l'interface Excel et de 
sélectionner ces paramètres manuellement chaque fois que la tâche sera requise. 
 

LA BOÎTE DE DIALOGUE RECORD MACRO  

Le Macro Recorder est utilisé pour créer une macro en enregistrant toutes les actions que vous 
effectuez dans Excel. Par exemple, si vous souhaitez créer une macro qui activera des 
paramètres de protection de feuille de calcul spécifiques, démarrez l'enregistreur, effectuez 
toutes les actions permettant d'appliquer ces paramètres, puis arrêtez l'enregistreur. Une fois 
le processus terminé, l'enregistreur de macros convertit les actions effectuées en code VBA et 
les enregistre en tant que macro que vous pouvez utiliser encore et encore. 
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Pour commencer à enregistrer une macro, vous devez d'abord ouvrir la boîte de dialogue 
Record macro en cliquant sur View → Macros → Record macro: 
 

 
Dans la boîte de dialogue Record macro, vous pouvez entrer des détails sur la macro que vous 
enregistrez, y compris le nom de la macro, la touche de raccourci pour exécuter la macro, 
l'emplacement où la macro doit être stockée et une brève description de ce que fait la macro: 

 
 

NOMMER DES MACROS  

Le nom d'une macro doit adhérer à un ensemble de règles de nommage:  
▪ Le nom doit commencer par une lettre majuscule ou minuscule.  
▪ Le nom ne peut contenir aucun espace.  
▪ Bien que le nom puisse contenir des lettres, des chiffres et le caractère de 

soulignement, il ne peut inclure aucun autre symbole ni aucun autre caractère.  
▪ Enfin, un nom de macro ne peut pas partager le nom d'un autre objet (tel qu'une feuille 

de calcul) ou d'un autre nom intégré (tel que «Fonction»). 
 
Sécurité des macros et format de fichier .xlsm  
 
De par leur nature, les macros représentent un risque pour la sécurité et, entre de mauvaises 
mains, elles peuvent causer de sérieux dommages à un fichier ou à un système informatique. 
Pour résoudre ce problème, les classeurs contenant des macros doivent être enregistrés au 
format de classeur activé pour les macros (.xlsm). Ce format offre une sécurité accrue contre les 
codes malveillants en vous invitant à activer ou désactiver manuellement les macros dans un 
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fichier. Ce système vous permet de déterminer la fiabilité d'une macro avant de l'exécuter. Si 
vous choisissez d'enregistrer un classeur contenant une macro dans un autre format, la macro 
ne sera pas enregistrée. 
 
Stockage de Macro  
 
Lorsque vous travaillez avec des macros, gardez à l'esprit qu'elles peuvent être stockées dans 
trois emplacements différents: le classeur actuel, un nouveau classeur ou votre classeur de 
macros personnelles. 
 
En choisissant d'enregistrer une macro dans le classeur actuel ou un nouveau classeur, la macro 
ne sera disponible que pour ces classeurs lorsqu'ils seront ouverts. 
 
Si vous créez une macro que vous devrez utiliser avec plusieurs classeurs, le classeur de macros 
personnelles est la meilleure option. N'oubliez pas que cette zone de stockage est propre à 
votre ordinateur et à votre compte d'utilisateur. Par conséquent, même si vous y aurez toujours 
accès sur votre ordinateur, ils ne seront pas stockés avec le classeur. 
 

VISUAL BASIC POUR APPLICATIONS  

(Visual Basic pour Applications)VBA est à la fois un langage de programmation couramment 
utilisé pour créer des macros pour les applications Microsoft Office et un Environnement de 
Développement Intégré (EDI). Même si vous créez une macro à l'aide de l'enregistreur de 
macros, celle-ci est toujours traduite en code VBA. Vous pouvez modifier ultérieurement le 
code VBA généré par l'enregistreur de macros à l'aide de VBA l'environnement de 
développement (Visual Basic Editor). 
 
L'éditeur Visual Basic  
L'éditeur Visual Basic  est l'environnement de développement utilisé pour créer et modifier des 
macros pour Excel et d'autres applications Microsoft Office. Cette application peut être ouverte 
directement depuis Excel (Developer → Visual Basic), mais elle s'ouvrira dans une fenêtre 
séparée:  
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Visual Basic Editor est composé de cinq panneaux et d’une zone de barre d’outils.  
▪ La  Code Window (1) vous permet de saisir ou de modifier directement le code de 

l'objet ouvert.  
▪ L' Object Browser (2) est masqué par défaut, mais répertorie tous les différents 

modules et classes pouvant être utilisés.  
▪ Le volet Project Explorer (3) répertorie les modules VBA dans tous les documents et 

modèles actuellement ouverts.  
▪ La Properties window (4) répertorie toutes les propriétés de l'objet sélectionné dans 

l'explorateur de projet ou dans la code window.  
▪ L' Immediate window (5) affiche des informations lorsque le code est en cours de 

débogage.  
▪ Enfin, la Standard toolbar (6) inclut de nombreuses commandes permettant d'interagir 

avec l'environnement VBA de différentes manières. 
 

COPIE DE MACROS ENTRE DES CLASSEURS 

Vous pouvez copier des macros entre des classeurs individuels à l'aide de Visual Basic pour 
Applications uniquement. Pour ce faire, ouvrez le classeur contenant la macro que vous 
souhaitez copier, ainsi que le ou les classeurs de destination vers lesquels vous souhaitez copier 
la macro. Ensuite, ouvrez VBA et examinez le volet  projets Explorer. Tous les classeurs 
actuellement ouverts (Book1 et Book2 dans cet exemple) sont répertoriés dans ce volet: 
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Toujours dans le volet Explorateur de projets, cliquez et faites glisser le module de la macro que 
vous souhaitez copier de sa liste dans le classeur de destination: 
 

 
 
La macro sera maintenant répertoriée dans le classeur d'origine, ainsi que le ou les classeurs de 
destination: 
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PARAMÈTRES DE SÉCURITÉ MACRO 

Excel inclut plusieurs protections qui vous aident à vous protéger contre les virus pouvant être 
transmis via des macros. L'une des garanties les plus importantes utilisées par Excel est la 
signature numérique, qui permet aux utilisateurs de vérifier que les macros proviennent d'une 
source fiable. Ainsi, si vous ouvrez un classeur contenant des macros, vous pouvez vérifier leur 
source avant de les activer. Cela peut aider à prévenir les infections virales, car les macros 
provenant de sources non fiables présentent un risque élevé de contenir du code malveillant. 
 
Pour accéder aux paramètres de sécurité des macros, cliquez sur Developer → Macro Security: 
 

 
 
(L'onglet Developer est masqué par défaut et doit être activé dans la catégorie Customize 
Ribbon de la boîte de dialogue Excel Options .) 
 
Vous pouvez également accéder aux paramètres de sécurité des macros en cliquant sur File → 
Options pour ouvrir la boîte de dialogue Excel Options. Ensuite, ouvrez la catégorie Trust Center 
et cliquez sur le bouton Trust Center Settings : 
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Dans les deux cas, la boîte de dialogue Trust Center s’affiche à l’écran. Cliquez sur la catégorie 
Macro Settings si elle n’a pas déjà été sélectionnée: 
 

 
 
Dans cette catégorie du Trust Center, vous avez le choix entre quatre boutons radio, chacun 
gérant les macros de différentes manières: 
 

 
 
Ces quatre boutons sont classés par ordre décroissant, du plus sécurisé au moins sécurisé, le 
paramètre par défaut étant «Disable all macros with notification». Ce paramètre constitue un 
bon compromis entre la désactivation de toutes les macros et l'activation de toutes les macros. 
 
Si vous désactivez toutes les macros, vous ne pourrez plus utiliser de macros, perdant ainsi les 
fonctionnalités fournies par celles-ci. Cependant, activer toutes les macros est très dangereux. 
ce paramètre augmentera considérablement le risque d’exécution de macros malveillantes. 
 
Les deux options du milieu sont généralement les plus utilisées. La troisième option, «Disable 
all macros except digitally signed macros», est un choix particulièrement judicieux. Cela 
exécutera toute macro signée numériquement par son auteur, mais pas celle qui n'est pas 
signée. Cela garantit que la macro en cours d'exécution provient d'une source approuvée. 
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La section Developer Macro Settings contient une case à cocher supplémentaire: 
 

 
 
Cette option est utilisée pour contrôler l'accès au modèle d'objet VBA à partir de toute macro. 
En vous assurant que cette case est désélectionnée, vous pouvez empêcher le code malveillant 
de se répliquer automatiquement. S'il existe une macro nécessitant un accès à ce modèle 
d'objet, cette case doit être cochée. Par défaut, il est désélectionné et il est préférable de le 
laisser tel quel, sauf dans des circonstances uniques. 
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SUJET C: Appliquer la Formatage 
conditionnelle 
 
Bien que les classeurs et les feuilles de calcul Excel puissent contenir toutes sortes de données 
importantes et enrichissantes, ces éléments importants peuvent parfois être perdus dans une 
multitude d'informations. Pour attirer l’attention sur les modèles ou les valeurs aberrantes dans 
vos données, Excel vous permet d’appliquer une mise en Formatage. La Formatage 
conditionnelle est souvent utilisée pour mettre en évidence des données intéressantes et 
pertinentes, mais elle peut aller beaucoup plus loin. Au cours de cette sujet, vous apprendrez le 
fonctionnement de la Formatage conditionnelle dans Excel 2016, ainsi que son application. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ À propos de la Formatage conditionnelle 
▪ À propos des Formatage conditionnels disponibles dans Excel 2016 
▪ À propos de la boîte de dialogue Conditional Formatting Rules Manager 
▪ À propos de la boîte de dialogue New Formatting Rule  
▪ À propos de la commande Clear Rules 

 

FORMATAGE CONDITIONNELLE 

La Formatage conditionnelle est un type de Formatage qui met en évidence les cellules dont 
les données répondent à certains critères. Il est utile pour les feuilles de calcul contenant des 
chiffres financiers (où le formatage noir peut correspondre à des valeurs positives, tandis que le 
formatage rouge peut être équivalent à des valeurs négatives), les résultats de test (où les 
résultats changent de couleur en fonction de leur valeur) ou chaque fois que vous souhaitez 
mettre en surbrillance les données. tombe dans une certaine valeur. 
 
Alors qu'Excel 2016 inclut certains critères par défaut que vous pouvez utiliser pour appliquer 
rapidement la Formatage conditionnelle, vous avez également la possibilité de créer vos 
propres critères et styles de Formatage conditionnelle à partir de rien. 
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FORMATS CONDITIONNELS 

Il existe un certain nombre de formats conditionnels que vous pouvez appliquer rapidement en 
cliquant sur Home → Conditional Formatting. Ici, vous verrez un certain nombre de types de 
format que vous pouvez choisir: 
 

 
 
Choisissez simplement un type de règle, puis cliquez sur une règle spécifique à appliquer. Voici 
une liste de tous les types de règles de formatage conditionnelle qui se trouvent dans ce menu. 
 
Mettre en surbrillance les règles de cellules 
 
Cela mettra en surbrillance les cellules qui sont supérieures, inférieures, entre ou égales aux 
valeurs spécifiées: 
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Règles Top / Bottom 
Cette option vous permettra de mettre en évidence les nombres ou pourcentages du haut ou 
du bas dans les cellules sélectionnées: 

 
Barres de données 
Affiche des barres de couleur indiquant la valeur dans la cellule. Plus la cellule est remplie, plus 
sa valeur est élevée par rapport aux autres cellules de la plage: 

 
Échelles De Couleur 
Utilisera différentes nuances de couleur pour représenter différentes valeurs, du plus bas au 
plus élevé: 
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Jeux d'icônes 
Utilisera des ensembles d’icônes similaires qui indiqueront visuellement la valeur d’une cellule: 

 
 
Vous pouvez appliquer plusieurs règles de formatage conditionnelle à un groupe de cellules en 
sélectionnant simplement de nouveau le groupe et en appliquant une autre condition. Ici, nous 
avons ajouté un jeu d’icônes aux données contenant déjà des barres de données: 
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BOÎTE DE DIALOGUE CONDITIONAL FORMATTING RULES MANAGER 

Lorsque vous créez et appliquez des conditional formatting rules  à vos données, vous devez 
être en mesure de les gérer correctement. Le Conditional Formatting Rules Manager a été 
fourni uniquement à cette fin. Vous pouvez y accéder en cliquant sur Home → Conditional 
Formatting → Manage Rules: 

 
 
Le Conditional Formatting Rules Manager liste toutes les règles de formatage qui ont été 
appliquées à la sélection actuelle. Il comprend également des boutons pour modifier, 
supprimer et créer des règles de formatage conditionnelles: 

 
Ci-dessous, vous pouvez voir une ventilation de chaque bouton dans la boîte de dialogue 
Conditional Formatting Rules Manager: 

Menu déroulant 
«Show formatting 
rules for» 

Ce menu déroulant permet de choisir 
l'élément de classeur pour lequel vous 
souhaitez afficher les règles de formatage. 
Cela peut être la sélection actuelle de 
cellules, la feuille de calcul actuelle ou des 
feuilles de calcul spécifiques dans le classeur 
actuel. 
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Bouton New Rule Cliquez sur ce bouton pour ouvrir la boîte de 
dialogue New Formatting Rule, qui peut 
ensuite être utilisée pour créer une nouvelle 
règle de formatage conditionnel. 

Bouton Edit Rule Cliquez sur ce bouton pour ouvrir la boîte de 
dialogue Edit Formatting Rule. Cette boîte de 
dialogue est identique à la boîte de dialogue 
Nouvelle règle de formatage, à la seule 
différence que vous l'utilisez pour modifier 
les règles de formatage conditionnel 
existantes. 

Bouton Delete Rule Ce bouton supprimera la règle de formatage 
conditionnelle sélectionnée. 

Boutons Move Up 
and Move Down 

Ces boutons vous permettent d’ajuster 
l’ordre de priorité des règles. La règle la plus 
haute sera exécutée avant les règles 
inférieures. 

Colonne «Rule 
(appliquée dans 
l'ordre indiqué)» 

Répertorie le nom de toutes les règles 
conditionnelles qui ont été appliquées à la 
sélection actuelle (ou de tout élément 
sélectionné dans le menu "Show formatting 
rules for"). 

Colonne de format Cette colonne affiche un aperçu de 
l’apparence de la Formatage conditionnelle 
pour chaque règle. 

Colonne «Applies to» Cette colonne répertorie la cellule ou la plage 
à laquelle chaque règle a été appliquée. 

Case à cocher Stop If 
True 

Cette case à cocher permet de contrôler les 
règles de formatage conditionnelle 
appliquées dans la liste. Par exemple, si 
quatre règles de formatage conditionnelle 
sont appliquées à une plage de données, 
vous pouvez cocher la case Stop If True pour 
la deuxième règle afin d'empêcher 
l'application des règles restantes. 
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LA BOÎTE DE DIALOGUE NEW FORMATTING RULE 

La boîte de dialogue New Formatting Rule permet de créer de nouvelles règles de formatage. 
Pour accéder à cette boîte de dialogue, cliquez sur Home → Conditional Formatting → New 
Rule: 
 

 
 
La boîte de dialogue New Formatting Rule est divisée en deux sections, Select a Rule Type et 
Edit the Rule Description: 

 
 



Excel 2016 Niveau 3 (Avancé)         23 

training@compuease.ca www.compuease.ca 613-235-6161 

La section Select a Rule Type répertorie six types de règles parmi lesquels vous pouvez choisir. 
Un clic sur un type de règle modifiera le contenu de la section Edit the Rule Description de la 
règle afin d'intégrer les contrôles pertinents pour la règle sélectionnée. 
 
Vous trouverez ci-dessous une brève description de chaque type de règle: 

Format all cells based 
on their values 

Il s'agit du même type de règle que celui 
utilisé dans les barres de données, les 
échelles de couleurs et les jeux d'icônes. Il est 
utilisé pour illustrer vos données dans 
chaque cellule par rapport à la plage de 
cellules sélectionnées (faible, moyenne et 
élevée). 

Format only cells that 
contain 

Cette règle est utilisée pour mettre en 
surbrillance les cellules qui remplissent une 
condition spécifiée. Par exemple, vous 
pouvez utiliser cette règle pour mettre en 
surbrillance les cellules inférieures à une 
valeur spécifiée. 

Format only top or 
bottom ranked 
values 

En utilisant cette règle, vous pouvez mettre 
en surbrillance un nombre personnalisé (ou 
un pourcentage) de valeurs supérieure ou 
inférieure dans une plage de données 
sélectionnée. 

Format only values 
that are above or 
below average 

Cette règle permet de mettre en surbrillance 
les valeurs supérieures ou inférieures à la 
valeur moyenne des cellules de la plage 
sélectionnée. De plus, cette règle vous 
permet également de mettre en surbrillance 
des données égales et supérieures à la 
moyenne, égales et inférieures à la moyenne, 
ou basées sur des écarts types de un, deux 
ou trois (supérieurs ou inférieurs). 

Format only unique 
or duplicate values 

Cette règle mettra en évidence les données 
qui sont un doublon d'une autre valeur de la 
plage sélectionnée ou qui lui sont propres. 

Use a formula to 
determine which 
cells to format 

Cette règle vous permet d'utiliser une 
formule ou une fonction pour mettre en 
surbrillance des cellules. 
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CLEAR RULES 

Pour supprimer les règles de formatage conditionnelles, cliquez sur Home → Conditional 
Formatting → Clear Rules: 
 

 
 
À l'aide des options du sous-menu, vous pouvez supprimer les règles de formatage 
conditionnelles d'une feuille de calcul, de cellules sélectionnées, du tableau sélectionné ou du 
Pivot Table sélectionné. 
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SUJET D: Ajouter des critères de Data 
Validation 
 
En limitant le type de données pouvant être entré dans votre classeur, vous pouvez éviter les 
erreurs de données et mieux contrôler vos données. Par exemple, il se peut que certaines 
données doivent être des nombres entiers, alors que d'autres peuvent être des valeurs 
décimales. Au cours de cette sujet, vous découvrirez la Data Validation et leur utilisation dans 
Excel 2016. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ A propos de la Data Validation 
▪ À propos de la boîte de dialogue de Data Validation 

 

LA DATA VALIDATION 

La Data validation est une partie importante de la conception et de la fonctionnalité des 
feuilles de calcul. Il est utilisé pour s'assurer que les bonnes données sont entrées au bon 
endroit. Par exemple, si vous avez une table de base de données contenant une colonne de 
chiffres de vente, vous ne voudrez plus pouvoir entrer accidentellement du texte dans la même 
colonne. Pour éviter que de tels problèmes ne se produisent, Excel vous permet de définir des 
règles de validation afin de vous assurer que les bonnes données sont entrées avec le bon 
format, au bon endroit. 
 

LA BOÎTE DE DIALOGUE DE DATA VALIDATION 

Pour configurer la Data Validation, vous devez d'abord ouvrir la boîte de dialogue Data 
Validation. Ceci est fait en cliquant sur Data → Data Validation: 
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La boîte de dialogue Data Validation affiche trois onglets: Settings, Input Message, et Error 
Alert. À l'aide des commandes de ces onglets, vous pouvez définir les critères, appliquer un 
message de saisie et définir une alerte d'erreur si des données erronées sont entrées: 

 
Ici, vous verrez les commandes et les contrôles dans chaque onglet de la boîte de dialogue 
Validation data et ce qu'ils peuvent faire: 

Settings Cet onglet vous permet de définir la règle de validation. Le champ 
Allow permet notamment de spécifier le type de données: 

▪ Any value, ce qui signifie aucune restriction sur le texte ou les 
chiffres 

▪ Whole numbers définis par une condition logique (<,>,> =, etc.) 
▪ Decimal numbers définis par une condition logique 
▪ List, définie par une plage de cellules d'un autre emplacement 
▪ Date définie par une condition logique 
▪ Time définie par une condition logique 
▪ Text length avec réglages de longueur min / max 
▪ Custom data définies par une formule adaptée à vos besoins 

Chaque type d'entrée est livré avec son propre ensemble de conditions 
afin que vous puissiez spécifier exactement ce qui est autorisé dans 
cette cellule. 

Input Message 
(optional) 

Utilisez cette option pour ajouter une notification à la cellule, 
avertissant les utilisateurs de son rôle et du type d'entrée autorisé. 
Vous pouvez entrer un titre et un court message descriptif. 

Error Alert 
(optional) 

Vous pouvez utiliser cet onglet pour écrire un message d'erreur 
expliquant les détails de l'incident. Ce message sera affiché si 
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quelqu'un entre des données incorrectes. Habituellement, le message 
d'erreur indique les limites de saisie pour cette cellule.  

Résumé 
Au cours de cette section, vous avez découvert différentes manières d’automatiser la 
fonctionnalité des feuilles de calcul. Vous devriez maintenant être à l'aise pour créer et éditer 
des macros de base, appliquer une formatage conditionnelle et ajouter des critères de data 
validation . 
 

Questions de révision 
 

1. Comment ouvrez-vous la boîte de dialogue Workbook Properties? 
 
 

2. En bref, que sont les macros? 
 
 

3. Les noms de macro peuvent-ils contenir des espaces? 
 
 

4. Que fera le format conditionnel de barres de données une fois qu'il est appliqué à un 
ensemble de données? 

 
 

5.Quelle est la séquence de commandes pour ouvrir la boîte de dialogue Data Validation ? 
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SECTION 2:  
ANALYSER ET PRÉSENTER DES 

DONNÉES 
 
 

Objectifs de la section 
 

Dans cette section, vous apprendrez comment: 

▪ Créer des sparklines 

▪ Créer des scenarios 

▪ Effectuer une analyse What-if 

▪ Effectuer une analyse statistique avec ToolPak d'analyse 

▪ Créer des données interactives avec Power View 
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SUJET A: Créer des  sparkline 
 
L'une des façons d'ajouter des éléments visuels aux données d'une feuille de calcul consiste à 
utiliser des  sparkline. Les  sparkline sont essentiellement des graphiques miniatures qui 
peuvent être insérés dans une seule cellule d'une feuille de calcul. Ce système vous permet non 
seulement de présenter les données de la feuille de calcul de manière visuelle, mais également 
de ne pas submerger ni obstruer les données numériques elles-mêmes. Au cours de ce sujet, 
vous en apprendrez davantage sur les graphiques sparkline et sur la manière dont ils peuvent 
être insérés dans vos feuilles de calcul. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ À propos des sparklines 
▪ À propos des types de  sparkline disponibles 
▪ À propos des  Sparkline tools - Design tab 
 

SPARKLINES 

Sparklines sont de petits graphiques contenus dans une cellule unique qui sont utilisés pour 
résumer les données et afficher les tendances. Ils peuvent être positionnés n'importe où et 
peuvent être personnalisés à votre guise. En outre, ils peuvent être créés pour une seule plage, 
puis étendus à plusieurs plages après leur création. 
 
Vous trouverez ci-dessous un  sparkline utilisé pour illustrer la dispersion des revenus générée 
par trois stores distincts: 
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TYPES DE  SPARKLINES 

Il existe trois types de  sparkline. 
 
Line 
Ce type de  sparkline est utilisé pour indiquer la tendance à la hausse ou à la baisse d'une 
collecte de données, comme si vous regardiez une hausse ou une baisse du prix des actions: 

 
 

Les marqueurs peuvent être utilisés pour mettre en évidence des points dans ce type de  
sparkline afin d'indiquer des points de données où la tendance change: 

 
 
Column 
Ces  sparkline sont similaires aux graphiques sparkline line, mais les données sont tracées dans 
un graphique à barres au lieu d'un graphique linéaire: 

 
 
Win/Loss 
Les  sparkline de ce type indiquent le nombre de fois que les données ont été supérieures ou 
inférieures à 0, indépendamment de la valeur possible des données: 

 
 

 SPARKLINE TOOLS –DESIGN TAB 

Une fois qu'un Sparkline a été inséré dans une cellule, l'onglet contextuel The Sparkline Tools – 
Design  apparaîtra sur le ruban: 
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Les commandes de cet onglet permettent de personnaliser et de formater l'apparence et la 
fonction des  sparkline. Voici un aperçu des groupes disponibles: 
▪ The Sparkline group contient une seule commande déroulante utilisée pour modifier 

ses données source et son emplacement sur la feuille de calcul. 
▪ TheType group contient des commandes permettant de basculer entre les trois types 

Sparkline. 
▪ The Show group contient six cases à cocher permettant d'activer ou de désactiver les 

éléments d'un  sparkline. 
▪ The Style group contient la galerie de style. C'est ici que vous pouvez choisir parmi un 

assortiment de styles préconfigurés à appliquer au  sparkline sélectionné. (En règle 
générale, ces styles ne modifient que les couleurs utilisées par Sparkline.) Ce groupe 
contient également des commandes permettant de formater les  sparkline avec une 
ligne personnalisée et / ou une couleur de marqueur. 

▪ Finally, the Group group contient des options permettant de grouping ou de ungrouping 
les  sparkline. Cela vous permet de formater et de modifier plusieurs  sparkline en une 
seule unité. Vous trouverez également l'option permettant de modifier la mise à 
l'échelle et la visibilité de chaque axe Sparkline. 
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SUJET B: Créer des scenarios 
Etre capable de prévoir les points de données futurs est un avantage évident dans tout secteur. 
Pour ce faire, Excel offre la possibilité de créer différents scénarios en fonction des données 
d’une feuille de calcul et d’analyser leurs résultats. Ces scénarios vous permettent de prévoir 
les résultats en fonction de vos données et de planifier l'avenir de manière significative. Au 
cours de cette sujet, vous en apprendrez plus sur les scénarios et sur la façon de les créer. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ À propos des scenarios 
▪ À propos des what-if de scenarios 
▪ À propos de la boîte de dialogue Manager dialog box 

 

SCENARIOS 

Dans Excel, un scénario peut être décrit comme un ensemble de valeurs de cellule qui sont 
enregistrées et substituées dans votre feuille de calcul à votre convenance. Si plusieurs 
scénarios sont enregistrés, vous pouvez charger différents scénarios dans votre feuille de calcul 
et les comparer afin de déterminer quel ensemble de valeurs donne les meilleurs résultats. 
 
Utilisés de cette manière, les scenarios Excel constituent un puissant outil d’analyse par 
simulation. Par exemple, vous pouvez utiliser des scenarios pour représenter différentes 
options budgétaires ou évaluer différentes prévisions financières. Vous pouvez également 
utiliser des scenarios pour comparer différentes projections de données basées sur un nombre 
quelconque de facteurs. 
 

LES OUTILS D'ANALYSE WHAT-IF 

Les scenarios ne sont que l’un des nombreux outils de what-if  proposés par Excel. Cet outil 
particulier vous permet de construire des modèles de données pour voir les résultats de 
différentes décisions et leur impact sur les données de votre feuille de calcul. Par exemple, vous 
pouvez créer un scénario qui aiderait à déterminer l'impact de la hausse de 5% des prix sur le 
revenu de votre entreprise. Ces informations peuvent être cruciales dans les processus 
décisionnels de l'entreprise. 
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LA BOÎTE DE DIALOGUE SCENARIO MANAGER 

Lors de la création de scénarios pour vos données, vous devez accéder à la boîte de dialogue 
Scenario Manager. Pour ce faire, cliquez sur Data→ What-If Analysis → Scenario Manager: 

 
Une fois ouverte, la boîte de dialogue Scenario Manager comprend des commandes vous 
permettant de créer de nouveaux scenarios et de gérer des scenarios existants: 

 
 

Voici un aperçu des commandes de cette boîte de dialogue: 
▪ Le bouton Add affiche la boîte de dialogue Add scenario. Ici, vous pouvez nommer et 

configurer le nouveau scénario. 
▪ Le bouton Delete permet de supprimer le scenario actuellement sélectionné dans le 

Scenario Manager. 
▪ Le bouton Edit vous permet de modifier la configuration d'un scenario sélectionné, 

tandis que le bouton Merge vous permet d'importer des scenarios à partir d'autres 
feuilles de calcul. 

▪ Le bouton Summary générera un rapport résumant les modifications apportées par le 
scenario actuel aux données de la feuille de calcul. 

▪ La zone de Comment vous permet de commenter le scenario actuellement sélectionné. 
▪ La zone de texte Changing Cells affiche les cellules de référence du scenario 

actuellement sélectionné et vous permet de les modifier. 
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SUJET C: Effectuer une analyse de What-
If 

 
La création de scénarios n’est qu’un des moyens d’effectuer une analyse What-If de vos 
données dans Excel. Vous pouvez également utiliser la fonctionnalité Goal Seek pour définir 
une formule sur une valeur (objectif) que vous souhaitez atteindre, puis spécifier l'une des 
cellules référencées par la formule en tant que cellule qu'Excel doit ajuster pour atteindre 
l'objectif. En outre, la fonction de résolution vous aide à résoudre des problèmes complexes. Au 
cours de ce sujet, vous en apprendrez plus sur ces outils. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ À propos des types de add-in 
▪ À propos de la fonctionnalité de Goal Seek 
▪ À propos de Solver tool 

 

TYPES DE ADD-IN 

Certains outils d'analyse de données intéressants fournis en tant que Add-In pour Excel, tels 
que Analysis ToolPak et the Solver. D'une manière générale, les add-ins peuvent être décrits 
comme de petits modules logiciels ou des fichiers qui étendent les fonctionnalités des 
applications Office plus grandes. 
 
Ce qu'il est important de savoir, c'est que ces add-ins ne sont pas activés dans Excel lors de son 
installation, car ils fournissent souvent des fonctionnalités plus obscures ou 
mathématiquement avancées que celles requises dans un environnement d'entreprise 
classique. Vous devez les activer manuellement depuis Excel. 
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Pour activer les add-Ins, la première étape consiste à accéder à la section add-in management 
de la boîte de dialogue Excel Options . Pour commencer, cliquez sur File → Options: 
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Lorsque la Windows Excel Options  s'ouvre, cliquez sur la Add-Ins category: 
 

 
 
Excel fournit une liste de tous les add-ins installés sur votre ordinateur et leur état actuel. Cette 
liste est divisée en sections suivantes: 

▪ Active Application Add-ins 
▪ Inactive Application Add-ins 
▪ Document Related Add-ins 
▪ Disabled Application Add-ins 

 
Si vous cliquez sur le menu déroulant Manage situé au bas de la Windows, vous verrez les 
options suivantes: 
 

 
 
Ici, vous pouvez voir deux types de add-ins en haut de la liste:  COM Add-ins et  Excel Add-ins. 
COM est synonyme de Component Object Model, une technologie Microsoft permettant aux 
composants logiciels (tels que les programmes Microsoft Office) de communiquer. Par exemple, 
une forme de technologie COM est utilisée pour permettre aux documents Word d’être liés aux 



Excel 2016 Niveau 3 (Avancé)         37 

training@compuease.ca www.compuease.ca 613-235-6161 

données contenues dans des feuilles de calcul Excel. Souvent, un seul complément COM sera 
disponible pour un certain nombre d'applications Office. 
 
Pour les besoins de cette sujet, nous nous intéressons aux Add-ins conçus spécifiquement pour 
Excel. Pour afficher et gérer ces Add-ins, sélectionnez Excel Add-ins dans la liste déroulante 
Manage combo et cliquez sur OK: 
 

 
 
Après avoir cliqué sur Go, la boîte de dialogue des Add-Ins apparaît et affiche une liste des Add-
Ins Excel disponibles: 
 

 
 
Si un Add-Ins est activé, une coche apparaît en regard de son nom dans la liste. Dans l'image ci-
dessus, aucun Add-Ins Excel n'est encore activé. Pour voir une brève description d'un Add-Ins, 
sélectionnez-le dans la liste, puis regardez au bas de la boîte de dialogue. Dans l'exemple ci-
dessus, Analysis ToolPak add-in est sélectionné et sa description apparaît en bas. 
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Pour activer un add-in particulier, cochez la case appropriée, puis cliquez sur OK. Ici, le Solver 
add-in est sur le point d'être activé: 
 

 
 
Si vous voyez une boîte de dialogue indiquant que le add-in que vous activez n'est pas 
actuellement installé sur votre ordinateur, cliquez simplement sur le bouton Yes pour l'installer. 
(Vous devrez peut-être également fermer et rouvrir Excel.) 
 

GOAL SEEK  

Goal Seek  est un outil d'analyse de scénarios what-if utile intégré à Excel. Il est utilisé pour 
rechercher les valeurs dans une cellule spécifiée qui mèneront à une valeur d'objectif spécifiée 
dans une autre cellule. En d'autres termes, vous pouvez définir une formule sur une valeur 
(objectif) que vous souhaitez atteindre, puis spécifier l'une des cellules référencées par la 
formule en tant que cellule qu'Excel doit ajuster pour atteindre l'objectif. 
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Prenez la feuille de calcul suivante comme exemple: 
 

 
 
Dans la barre de formule, vous pouvez voir que la formule Bénéfice total correspond au revenu 
total (B4) moins le coût total (B7). Il convient de noter que les cellules B4 et B7 contiennent 
elles-mêmes des formules. La formule dans la cellule B4 est = B2 * B3 (unités vendues 
multipliées par le prix unitaire). La formule dans la cellule B7 est = (B5 * B2) + B6 (Matériau par 
unité multiplié par les unités vendues) plus la main-d'œuvre nécessaire à la fabrication des 
unités. 
 
L'image suivante montre la feuille de calcul avec quelques exemples de données: 
 

 
 
De toute évidence, aux niveaux de production actuels, l’entreprise perd des bénéfices. 
Comment calculeriez-vous le nombre d'unités à fabriquer pour atteindre le seuil de rentabilité 
ou réaliser un profit? Une solution consiste à utiliser Goal Seek pour rechercher un seuil de 
rentabilité basé sur les modifications apportées à une cellule référencée (directement ou 
indirectement) par la formule de profit de la cellule B8. 
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Pour commencer, nous allons sélectionner la cellule B8 (la cellule avec la formule de profit). 
Ensuite, nous invoquerons la boîte de dialogue Goal Seek en sélectionnant Data → What-If 
Analysis → Goal Seek: 

 
 
Lorsque la boîte de dialogue Goal Seek apparaît, B8 est déjà entré dans la case «Set cell» car il 
s'agit de la cellule que nous avons sélectionnée juste avant l'appel de la Goal Seek: 
 

 
 
Dans la zone «To value», nous entrerons 0 (puisqu'un bénéfice de 0 est le seuil de rentabilité). 
Dans le champ "By changing cell", nous allons entrer B2 (le nombre d'unités requis). Lorsque 
tout est configuré, la boîte de dialogue Goal Seek ressemble à l'image suivante: 
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Lorsque vous cliquez sur OK, Goal Seek trouve une valeur pour la cellule B2 (unités vendues) qui 
rendra la formule de profit (B8) égale à 0 (seuil de rentabilité): 
 

 
 
La boîte de dialogue Statut de la Goal Seek indique qu'une solution a été trouvée et vous 
pouvez voir la valeur 300 dans la cellule B2. Cela signifie que si toutes les autres variables 
restent inchangées, vous devez vendre 300 unités pour atteindre le seuil de rentabilité. À ce 
stade, vous pouvez cliquer sur Cancel pour restaurer les valeurs d'origine de la feuille de calcul 
ou sur OK pour saisir les valeurs de la solution Goal Seek dans la feuille de calcul. 
 

L'OUTIL SOLVER 

Solver est utilisé pour définir une cellule spécifiée à une certaine valeur, ce qui aura alors pour 
effet de modifier les autres cellules associées à la cellule en question pour qu'elles 
correspondent à la nouvelle valeur. Par exemple, supposons que vous souhaitiez augmenter les 
bénéfices de l'entreprise de 5%. En définissant cette option sur le bénéfice actuel, majoré de 
5%, d'autres domaines, tels que les ventes, les coûts de personnel et les coûts de matériau, 
seront modifiés en conséquence pour correspondre à la nouvelle valeur. 
 
Notez que pour utiliser Solver, vous devez activer le add-in associé. Voir le premier concept de 
cette rubrique pour plus d'informations. 
 
La boîte de dialogue Solver Parameters 
Pour commencer à utiliser le solver, ouvrez la boîte de dialogue Solver Parameters en cliquant 
sur Data → Solver:  
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La boîte de dialogue Solver Parameters s'ouvre: 

 
 

En haut de cette boîte de dialogue, le champ Set Objective vous permet de définir la cellule de 
l'objectif dans laquelle vous souhaitez afficher le résultat cible. Les boutons radio To 
permettent de définir une valeur maximale, minimale ou fixe souhaitée dans la cellule d'objet. 
La zone de texte Par By Changing Variable Cells  vous permet de saisir les références de cellule 
des cellules variables. Ce sont les cellules qui vont changer pour atteindre la valeur de la cellule 
objectif. 
 
Ensuite, la liste "Subject to the Constraints" listera toutes les contraintes existantes. En cliquant 
sur le bouton Add, vous pourrez ajouter une nouvelle contrainte, tandis que le bouton Change 
affichera la boîte de dialogue Change Constraint . Là, vous pouvez ajuster la contrainte 
sélectionnée en conséquence. Le bouton Delete supprime une contrainte sélectionnée, tandis 
que le bouton Load/Save charge ou enregistre un modèle posant problème.  
 
Cliquez sur le bouton Options pour afficher un ensemble de fonctionnalités avancées. Cliquez 
sur le bouton Solve pour tenter de résoudre le problème décrit dans cette boîte de dialogue. 
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SUJET D: Effectuer une analyse 
statistique avec l' Analysis ToolPak 
 
Tout comme Solver tool, Analysis ToolPak est un add-in fourni avec Microsoft Excel 2016 qui 
doit être activé avant de pouvoir être utilisé. Ce add-in vous donne accès à un large éventail 
d’outils statistiques destinés à analyser vos données et à obtenir une meilleure image des 
tendances ou des valeurs aberrantes qu’elles contiennent. Au cours de cette Sujet, vous en 
apprendrez plus sur le  Analysis ToolPak Add-in et sur son utilisation. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ A propos de L' Analysis ToolPak 
▪ À propos de la boîte de dialogue Data Analysis 

 

ANALYSIS TOOLPAK 

Une fois Analysis ToolPak activé, à l'aide des commandes de la catégorie Add-ins de la boîte de 
dialogue Excel Options, vous pouvez le lancer en cliquant sur Data → Data Analysis: 
 

 
 
L' add-in Analysis ToolPak fournit une gamme d'outils permettant d'analyser des données 
scientifiques, statistiques ou liées à l'ingénierie. Une exploration complète de l'utilisation de ces 
outils dépasse le cadre de ce manuel. 
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LA BOÎTE DE DIALOGUE DATA ANALYSIS 

Si vous cliquez sur le bouton Data Analysis sous l'onglet Data, la boîte de dialogue Data Analysis 
s'affiche avec une liste d'outils pouvant défiler à l'écran: 
 

 
 
Les outils disponibles dans la liste sont destinés à des techniques d'analyse de données bien 
spécifiques et avancées. Pour démarrer l’un des outils, sélectionnez-le dans la liste, puis cliquez 
sur OK: 
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SUJET E: Créer des données interactives 
avec Power View 
 
Power View est un outil interactif de visualisation et d'exploration de données, idéal pour de 
nombreuses tâches. Au cours de cette Sujet, vous en saurez plus sur Power View, comment 
l'activer et comment utiliser plusieurs de ses fonctionnalités. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ À propos du Power View add-in 
▪ Comment activer Power View 
▪ Comment créer une Power View 

 

LE POWER VIEW ADD-IN 

Power View est un type de canevas interactif sur lequel vous pouvez créer et afficher des 
graphiques, des tableaux, des cartes et des segments, le tout dans une Window de tableau de 
bord. Ce qui fait de Power View un outil aussi puissant, c’est que tout ce qui se trouve à 
l’intérieur du tableau de bord est lié afin de pouvoir répondre aux modifications et aux 
sélections. Par exemple, si vous sélectionnez un composant d'un graphique, d'autres zones du 
tableau de bord peuvent vous afficher les détails et les données qui constituent ce composant. 
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ACTIVATION DE POWER VIEW 

Power View est en fait un type de add-in COM qui doit être activé avant de pouvoir l'utiliser. 
Pour activer Power View, ouvrez d’abord la Window Excel Options  en cliquant sur File → 
Options: 
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Lorsque la boîte de dialogue Options Excel est ouverte, vous devez ensuite afficher la catégorie 
Add-Ins. Cette catégorie répertorie tous les compléments disponibles pour Excel 2016. Au bas 
de cette boîte de dialogue, utilisez le menu Manage drop-down  pour sélectionner les COM 
Add-ins: 
 

 
 
Avec les COM Add-ins sélectionnés, puis cliquez sur le bouton OK: 
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La boîte de dialogue  COM Add- ins s'affiche alors. À l'intérieur de cette boîte de dialogue, tous 
les COM add-ins disponibles que vous pouvez activer sont répertoriés. Dans ce cas, cochez la 
case Microsoft Power View pour Excel, puis cliquez sur le bouton OK: 
 

 
 
Power View sera ensuite activé pour votre installation d'Excel 2016. Pour tirer parti de cette 
fonctionnalité, vous devez toutefois ajouter la commande Power View à un groupe 
personnalisé dans l'un des onglets principaux. Pour ce faire, utilisez la catégorie Customize 
Ribbon de la boîte de dialogue Excel Options : 
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Une fois la commande Power View ajoutée au ruban, vous pouvez lancer Power View en 
cliquant dessus: 
 

 
 

CRÉER UNE POWER VIEW 

Power View est essentiellement utilisé pour créer des rapports visuels basés sur des ensembles 
de données. Alors que Excel inclut de nombreux graphiques et options de visualisation, Power 
View est unique en ce sens que vous obtenez un filtrage croisé automatique des visualisations, 
de nouvelles visualisations qui ne sont pas normalement dans Excel, options de filtrage (par 
exemple, curseurs) et prise en charge des images. 
 
Pour créer une Power View, sélectionnez d'abord la plage de données source que vous 
souhaitez utiliser, puis cliquez sur la commande Power View. Après quelques instants de 
traitement, votre feuille de calcul Power View s'ouvre. Vous verrez que toutes les données 
précédemment sélectionnées ont été organisées dans un tableau simple. Les champs de ces 
données seront listés dans le volet Champs du Power View à droite de la Window: 
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Résumé 
Au cours de cette section, vous avez découvert les nombreux outils d'Excel 2016 que vous 
pouvez utiliser pour analyser vos données. Vous devez maintenant être à l'aise pour créer des 
graphiques sparkline pour illustrer vos données, ainsi que pour créer des scénarios permettant 
de prévoir les conséquences des modifications apportées à vos données. Vous devez 
maintenant savoir comment procéder à une analyse de what-if et comment la mener dans 
Excel 2016 à l'aide des différents outils disponibles. En outre, vous devriez maintenant pouvoir 
effectuer une analyse de données à l'aide de L' Analysis ToolPak. 
 

Questions de révision 
 
1.Quel type des Adds-in est Power View? 
 
 
2.Quels sont les trois types de sparklines? 
 
 
3.Quelle est la séquence de commandes pour ouvrir la boîte de dialogue Scenario Manager? 
 
 
4.À quoi sert la fonctionnalité de Goal Seek? 
 
 
 
5.Le Analysis ToolPak add-in est-il activé par défaut? 
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SECTION 3: 
TRAVAILLER AVEC PLUSIEURS CLASSEURS 
 
 
Objectifs de la section 
 

Dans cette section, vous apprendrez comment: 

▪ Consolider les données 

▪ Lier des cellules dans différents classeurs 

▪ Fusionner des classeurs 
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SUJET A: Consolider les données 
 
Lorsque vous travaillez avec Excel, vous pouvez être amené à référencer des données dans 
plusieurs classeurs distincts. Normalement, la tâche serait difficile, mais avec les fonctions de 
consolidation d’Excel, vous pouvez résumer les données de plusieurs feuilles de calcul en une 
seule. Au cours de cette rubrique, vous apprendrez à consolider les données de différentes 
feuilles de calcul en un résumé condensé. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ A propos de la consolidation des données 
▪ À propos de la boîte de dialogue Consolidation 
▪ A propos des fonctions de consolidation 

 

CONSOLIDATION DE DONNÉES 

Lorsque vous consolidez des classeurs, vous combinez, condensez et récapitulez les données de 
plusieurs sources en une seule destination. Par exemple, une grande entreprise peut disposer 
de données sur les ventes ou les bénéfices réparties dans plusieurs zones géographiques et 
stockées dans différents classeurs. Chaque classeur aura la même présentation et la même 
structure (modèle), mais les données de chacun seront différentes. Avec Excel, vous pouvez 
consolider les différents classeurs, en résumant et en totalisant les données en un seul endroit 
pour obtenir une vue unifiée de vos informations. 
 
Pour lancer le processus de consolidation des données, cliquez sur Data → Consolidate: 

 
 
Suivi des modifications 
 
Lorsque vous travaillez avec plusieurs classeurs, il est généralement conseillé de garder une 
trace de toutes les modifications apportées à vos données (telles que la consolidation des 
données). La fonction de Track Changes enregistre toutes les modifications afin que vous 
puissiez les accepter ou les refuser. 
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LA BOÎTE DE DIALOGUE DE CONSOLIDE 

Lorsque vous cliquez sur Data → Consolidate, la boîte de dialogue Consolidate s'affiche: 

 
 

Voici un aperçu des commandes dans la partie supérieure de cette boîte de dialogue: 
▪ Le menu déroulant Function contient une variété de fonctions que vous pouvez utiliser 

pour combiner des données. 
▪ La zone de Reference est l'endroit où vous entrez les plages de données à consolider. 

Vous pouvez entrer les plages manuellement ou en les sélectionnant dans les différents 
classeurs avec votre souris ou votre clavier. (Cette dernière méthode est recommandée 
car elle est beaucoup plus facile.) 

▪ Une fois une plage entrée, cliquez sur Add pour l’ajouter à la case «All references». 
Cette liste contiendra toutes les références de cellules de classeur à consolider. 

 
Au bas de la boîte de dialogue, vous remarquerez la section "Use labels in", avec deux cases à 
cocher en dessous: 

 
 
Vous pouvez cocher ces cases pour consolider les feuilles uniquement à partir d'étiquettes de 
lignes ou de colonnes. Cela signifie que les données des colonnes ou des lignes portant les 
mêmes étiquettes seront consolidées, même si elles portent des lettres de colonne ou des 
numéros de ligne différents dans les classeurs source. (C’est la raison pour laquelle la 
consolidation est plus facile lorsque toutes les feuilles de calcul impliquées ont les mêmes 
étiquettes et la même présentation.) Pour cet exemple, les cases à cocher sont vides, de sorte 
que la consolidation sera basée sur les emplacements réels des cellules. 
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Si vous cochez la case "Create links to source data", les informations du classeur de destination 
seront mises à jour si le contenu du classeur source ayant contribué est modifié. 
 

FONCTIONS DE CONSOLIDATION 

Le menu Function de la boîte de dialogue Consolidation contient diverses fonctions que vous 
pouvez utiliser pour combiner des données. Ci-dessous, vous pouvez voir une brève liste de 
toutes les fonctions disponibles: 
 

Sum Ajoute toutes les valeurs de la liste. 

Count Fournit un nombre de cellules contenant des 
données. 

Average Affiche la valeur moyenne dans la liste. 

Max Donne le numéro le plus élevé de la liste. 

Min Donne le numéro le plus bas de la liste. 

Product Multiplie tous les nombres de la liste. 

Count Numbers Compte le nombre de cellules dont les valeurs 
répondent à un critère spécifié. 

StdDev Fournit l'écart type de la liste, si celle-ci est un 
échantillon d'une plus grande population de 
données. 

StdDevp Fournit l'écart type de la liste, si celle-ci 
comprend la population entière de données. 

Var Donne la variance de la liste, si celle-ci est 
l'échantillon d'une plus grande population de 
données. 

Varp Donnera la variance de la liste, si celle-ci 
comprend toute la population de données. 
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SUJET B: Cellules de liaison dans 
différents classeurs 
 
Dans Excel 2016, vous avez non seulement la possibilité de créer un lien vers les cellules de la 
feuille de calcul du classeur en cours; vous pouvez également créer un lien vers des cellules de 
feuille de calcul dans des classeurs entièrement séparés. Dans cette sujet, vous en apprendrez 
davantage sur les références externes et sur la façon de les créer. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 

• A propos des références externs 
 

RÉFÉRENCES EXTERNES 

Les références externes (parfois appelées liens) font référence au contenu d'une cellule ou de 
cellules de la feuille de calcul d'un autre classeur. L’avantage principal de la liaison à des cellules 
d’autres classeurs est de gagner du temps. 
 
Bien que les références externes partagent une grande partie de la même syntaxe que les 
références de cellules typiques dans Excel 2016, il existe quelques différences essentielles. Tout 
d'abord, vous pouvez créer des références externes de deux manières différentes selon que le 
classeur référencé est ouvert ou non. 
 
Si le classeur référencé est ouvert, vous pouvez inclure le nom du classeur entre crochets, suivi 
du nom de la feuille de calcul, d'un point d'exclamation, puis de la référence de cellule: 
 

 
 
Si le classeur référencé est ou sera fermé lorsque cette référence externe est utilisée ou créée, 
vous devez formater différemment la référence de cellule externe. Dans ce cas, la référence 
externe doit inclure le chemin d'accès complet au classeur en question, suivi du nom du 
classeur entre crochets, du nom de la feuille de calcul, d'un point d'exclamation et enfin de la 
référence de cellule: 
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(Notez que le chemin du fichier, le nom du classeur et le nom de la feuille de calcul doivent être 
placés entre guillemets lors de la création de ce type de référence externe.) 
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SUJET C: Fusionner des classeurs 
Si vous travaillez avec plusieurs classeurs partagés, il peut être judicieux de les fusionner en un 
seul classeur à un moment donné. Pour simplifier ce processus, Excel 2016 inclut les 
fonctionnalités de comparaison et de fusion, qui effectuent tout le travail à votre place. Au 
cours de cette rubrique, vous apprendrez à fusionner des classeurs à l'aide de la fonctionnalité 
Compare et Merge. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 

• À propos de la fonctionnalité de classeurs de Compare et Merge 
 

FONCTIONNALITÉ DES CLASSEURS DE COMPARE ET MERGE 

Dans Excel 2016, la fonctionnalité Compare et Merge est utilisée pour fusionner plusieurs 
copies d'un classeur partagé en un seul. Cette fonctionnalité est uniquement compatible avec 
les classeurs partagés avec d'autres utilisateurs. Ainsi, lorsqu'un autre classeur partagé est mis à 
jour par d'autres utilisateurs, vous pouvez comparer les modifications qu'ils ont apportées 
avant de les fusionner avec votre copie. En outre, tous les classeurs que vous choisissez de 
fusionner doivent avoir un nom de fichier unique et être stockés dans le même dossier avant de 
pouvoir continuer. 
 
Notez que la commande Compare et Merge n'apparaît nulle part sur l'interface Excel 2016 par 
défaut. L'endroit le plus facile à ajouter est la barre d'outils Quick Access, mais vous pouvez 
l'ajouter à un onglet ou à un groupe custom si vous le souhaitez. 
 
Vous pouvez le faire à partir de la catégorie appropriée de la boîte de dialogue Excel Options. 
Vous trouverez la commande "Compare and Merge Workbooks" dans la liste Toutes les 
commandes sélectionnée à l'aide du menu déroulant "Choose commands from": 
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La commande sera alors disponible dans la barre d'outils Quick Access afin que vous puissiez 
lancer le processus. 
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Résumé 
Au cours de cette section, vous avez appris à utiliser plusieurs classeurs de différentes 
manières. Vous devriez maintenant être à l'aise avec la consolidation de données à l'aide des 
outils d'Excel 2016. En outre, vous devriez maintenant pouvoir créer des liens vers des cellules 
de différents classeurs et utiliser la fonctionnalité Compare and Merge Workbooks. 
 

Questions de révision 
 
1.Qu'est-ce que cela signifie pour consolider les données? 

 

2.Quelle est la séquence de commandes pour ouvrir la boîte de dialogue Consolidate? 

 

3.Que fait la fonction de consolidation Sum? 

 

4.Quel caractère spécial doit précéder la référence de cellule réelle lors du référencement de 

cellules dans un autre classeur? 

 

5.Le bouton «Compare and Merge Workbooks» est-il affiché par défaut dans la barre d'outils 

Quick Access?  
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SECTION 4: 
ANALYSE DES DONNÉES AVEC 

DES PIVOT TABLES, SLICERS, 
AND PIVOT CHARTS 

 
 
 

Objectifs de la section 
Dans cette section, vous apprendrez comment: 

▪ Créer un Pivot Table 

▪ Filtrer les données à l'aide de slicers 

▪ Analyser les données à l'aide de Pivot Charts 
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SUJET A: Créer un Pivot Table 
 
Le Pivot Table est l’un des outils les plus puissants dont vous disposez pour analyser des 
données dans Excel. Bien qu'extrêmement utiles, ces objets interactifs sont quelque peu 
encombrants à exécuter correctement et sont souvent mal utilisés. Pour cette raison, il est 
important de comprendre leur fonctionnement et d'acquérir une compréhension fondamentale 
de leur objectif avant de créer des Pivot Table de vos propres données. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ A propos des Pivot Tables 
▪ Comment commencer avec des questions et finir avec une structure 
▪ À propos de la boîte de dialogue Create Pivot Table 
▪ À propos du volet des champs du Pivot Table 
▪ Comment résumer des données dans un Pivot Table 
▪ À propos de la fonctionnalité «Show value as» 
▪ A propos de l'utilisation de données externes avec les Pivot Table 
▪ À propos de Power Pivot 
▪ À propos des fonctions Power Pivot 
▪  

PIVOTTABLES 

Pourquoi les Pivot Tables sont-ils appelés Pivot Tables? Parce qu'ils vous permettent de 
déplacer facilement des données (en glissant-déposant des champs) pour effectuer une sorte 
de rotation sur la structure de votre tableau et en même temps, modifier votre affichage des 
données. Avec les Pivot Tables, les colonnes peuvent devenir des lignes et les lignes peuvent 
devenir des colonnes sans modifier les données d'origine. 
 
Lorsqu'un Pivot Table  est créé, vous avez la possibilité de le mettre sur la feuille de calcul 
ouverte ou sur une nouvelle. Dans les deux cas, une fois le Pivot Table  créé, vous pouvez faire 
pivoter, re-pivoter, trier et résumer vos données sans l’affecter directement. Vous êtes en 
mesure de choisir le niveau de détail que vous souhaitez afficher en fonction de vos besoins. De 
plus, vous avez accès à toutes les fonctions de résumé d'Excel pour compléter votre analyse de 
données. 
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Vous trouverez ci-dessous un exemple de Pivot Table  très simple: 
 

 
 

Dans ce cas, les colonnes Location, Quantity, et Order Price de la commande ont été pivotées 
pour apparaître sous forme de lignes. Un résumé de chaque colonne numérique de ce Pivot 
Table est affiché par défaut. 
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COMMENCEZ PAR DES QUESTIONS, TERMINEZ PAR UNE STRUCTURE 

Avant même de créer un Pivot Table, vous devez penser aux questions auxquelles vous essayez 
de répondre en l’utilisant. Tout comme lorsque vous travaillez avec des functions ou des 
formulas, la moitié du travail en analyse de données consiste à trouver les bonnes questions. Ce 
processus est particulièrement important pour les Pivot Tables, car leur construction dépend de 
la question que vous vous posez. Une fois que vous avez la question à laquelle vous souhaitez 
que le Pivot Tables réponde, vous pouvez commencer à le construire. Bien qu'il n'y ait pas de 
règles strictes pour la construction d'un Pivot Tables, il y a plusieurs façons de simplifier les 
choses. 
 

Voici quelques conseils à garder à l’esprit lors de la construction de votre Pivot Table. 
▪ Tout d'abord, il est généralement préférable de créer des lignes et des colonnes à l'aide 

de champs comportant un nombre défini d'entrées relativement faible. L'utilisation 
d'entrées couvrant une grande quantité de données (telles que cinq ans de numéros de 
transaction) pour créer des lignes et des colonnes ne peut que semer la confusion plutôt 
que de répondre à des questions spécifiques. 

▪ Ensuite, il est presque toujours judicieux de créer une ligne à partir d'un champ pour 
lequel vous souhaitez une réponse, puis de créer une colonne à partir de ce critère pour 
affiner la réponse. 

 
Examinez la feuille de travail ci-dessous. Vous verrez une plage contenant 18 entrées: 

 
 
Un Pivot Table créé à partir de cet ensemble de données répond à la question «What is the 
total value of the products stored in each warehouse?" 
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Comme vous pouvez le constater, les entrepôts sont répertoriés par ligne et le prix (le critère) 
sous forme de colonne. Une fonction SUM additionne automatiquement le prix de la 
commande de chaque prix de produit stocké par chaque entrepôt. 
 
Vous pouvez modifier la fonction utilisée par le Pivot Table par tout ce dont vous avez besoin 
pour répondre à une question. Par exemple, supposons que vous vouliez connaître le nombre 
de produits différents de chaque entrepôt, et non un nombre total. Vous pouvez le faire en 
ajoutant le champ SKU en tant que colonne et en appliquant la fonction COUNT: 

 
 

LA BOÎTE DE DIALOGUE CREATE PIVOT TABLE 

La première étape pour créer un Pivot Table consiste à ouvrir la boîte de dialogue Create un 
Pivot Table en cliquant sur Insert → Pivot Table: 
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Les commandes de la boîte de dialogue Create un Pivot Table permettent de choisir l'ensemble 
de données (ou la source de données) pour le nouveau Pivot Table que vous créez et 
l'emplacement où vous souhaitez le placer. Par défaut, les nouveaux Pivot Table sont placés sur 
de nouvelles feuilles de calcul, mais vous avez la possibilité de les ajouter aux feuilles de calcul 
existantes de votre classeur: 

 
Une fois que vous avez défini vos options, cliquez sur OK pour créer le Pivot Table. 
 

LE VOLET DES PIVOT TABLE FIELDS 

Lorsque vous insérez un Pivot Table dans votre classeur, le volet de tâches Pivot Table Field 
s'affiche automatiquement dans la partie droite de la Windows Excel 2016: 
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Le volet Liste des Pivot Table Field est le principal outil que vous utiliserez pour configurer les 
Pivot Tables. (Notez qu'il est masqué lorsque le Pivot Tables n'est pas sélectionné.) La partie 
supérieure de ce volet (1) répertorie tous les champs de l'ensemble de données que vous 
pouvez ajouter au Pivot Tables. Pour ajouter ou supprimer un champ du Pivot Tables, cochez la 
case correspondante. Vous pouvez également cliquer sur les champs et les faire glisser vers le 
Pivot Tables pour mieux contrôler l’emplacement des champs dans le Pivot Tables. Notez que 
les noms de champ sont dérivés de l'en-tête de colonne de l'ensemble de données: 
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La partie inférieure de ce volet est composée de quatre zones (2): Filters, Columns, Rows, and 
Values. Si vous faites glisser des champs entre ces zones, vous pouvez modifier la structure du 
Pivot Table et choisir les valeurs à utiliser pour effectuer des calculs. 

Voici un aperçu de ces quatre domaines. 
▪ L'ajout de champs à la zone Filter inclura ces valeurs de champ en tant que critères de 

filter. 
▪ La  zone Columns créera des colonnes à partir d'entrées de champs uniques. 
▪ De la même manière, la zone Rows créera des lignes à partir d'entrées de champs 

uniques. 
▪ Enfin, des calculs ou des valeus sont résumés dans les champs glissés dans la zone 

Values. 
▪ Notez que tous les champs qui apparaissent dans ces quatre zones incluront une flèche 

déroulante (3) qui vous donnera accès à différents paramètres et à la boîte de dialogue 
Field Settings que vous pourrez utiliser pour personnaliser davantage votre Pivot Table. 

 
N'oubliez pas que toutes les modifications que vous apportez dans le volet Liste des Pivot Table 
Field seront appliquées de manière dynamique. De plus, en raison de la nature flexible des 
Pivot Tables, vous pouvez ajouter ou supprimer des champs dans le volet à tout moment. 
 

RÉSUMER LES DONNÉES DANS UN PIVOT TABLE 

En combinant les options des onglets Summarize Values By et le Show Values As en tant que de 
la boîte de dialogue Field Settings de valeur, vous pouvez mieux comprendre vos données. Par 
exemple, supposons que vous souhaitiez calculer le prix unitaire total de tous les produits 
stockés par chaque magasin. Pour ce faire, faites glisser le champ Unit price dans la zone Values 
du volet Liste des Pivot Table Field. Cliquez ensuite sur la flèche déroulante de ce champ, puis 
sur l’option Field Settings pour ouvrir la boîte de dialogue Value Field Settings. Dans la boîte de 
dialogue Paramètres du champ de valeur, vous devez vous assurer que la fonction Sum est 
sélectionnée: 
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Le Pivot Table affichera ensuite la somme des prix unitaires trouvés dans chaque entrepôt: 

 

 
 

FONCTIONNALITÉ «SHOW VALUES AS» D'UN PIVOT TABLE 

Supposons maintenant que vous souhaitiez voir le pourcentage du total que chaque entrepôt 
détient en valeur. Bien que vous puissiez faire ce calcul manuellement, il serait plus facile de 
changer la manière dont les valeurs sont affichées. Dans l'onglet Show Values As  de la boîte de 
dialogue Value Field Settings, cliquez sur l'option «% of Grand Total» dans le menu déroulant 
«Show values as»: 

 
 

Vous allez maintenant voir quel pourcentage du total général de chaque entrepôt détient. Dans 
ce cas, vous pouvez voir que l’entrepôt A contient la grande majorité de la valeur des produits, 
tandis que l’entrepôt C en possède le moins: 
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DONNÉES EXTERNES 

Si les données que vous souhaitez analyser existent en dehors d'Excel, telles qu'une base de 
données Microsoft Access, vous pouvez toujours utiliser des Pivot Tables pour les résumer. 
Pour ce faire, vous devez créer une connexion à ces données externes en ouvrant la boîte de 
dialogue Create Pivot Table, puis en cliquant sur le bouton radio "Use an external data source". 
Ensuite, cliquez sur le bouton Choose Connection button: 
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La boîte de dialogue Existing Connections vous permettra ensuite de choisir parmi les 
connexions existantes existantes et de rechercher d'autres connexions: 

 
 

POWERPIVOT 

Power Pivot est un add-in Excel disponible pour Excel 2016. Il s'agit d'un logiciel supplémentaire 
inclus dans certaines éditions d'Excel 2016, mais pas dans sa totalité. Dans les cas où il n'est pas 
inclus, il peut être ajouté ultérieurement si nécessaire. Une fois installé, ce logiciel 
supplémentaire étend les fonctionnalités d'Excel pour permettre une plus grande analyse des 
données. 
 
La particularité de Power Pivot réside dans le fait qu’il utilise des algorithmes de compression et 
de processing qui vous permettent de travailler efficacement avec de grandes quantités de 
données. Cela facilite l'analyse avec des données avec lesquelles il serait trop lourd de 
travailler. De plus, Power Pivot facilite également l'intégration de données provenant de 
plusieurs sources et a été conçu avec des fonctionnalités et une flexibilité supplémentaires pour 
les environnements reposant sur Microsoft SharePoint et / ou les serveurs Microsoft SQL. 
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FONCTIONS POWER PIVOT 

DAX (Data Analysis Expression) est un type de langage de formule utilisé pour créer des calculs 
personnalisés dans des colonnes calculées dans un tableau Power Pivot. Il est également utilisé 
pour créer des mesures dans un Pivot Table. Cela signifie que Power Pivot vous fournit des 
fonctions supplémentaires utilisant DAX qui peuvent être utilisées pour travailler avec des 
données relationnelles de manière beaucoup plus puissante. 
 
Les arguments d'une fonction DAX utilisent généralement des tables et des colonnes. Par 
exemple, vous pouvez voir ci-dessous une fonction DAX utilisant les colonnes Totals et Date de 
la table Employee Sales comme arguments: 
 

= TOTALQTD (SUM (‘Ventes des employés’ [Totaux]), ‘Ventes des employés’ [Date]) 

 
Vous pouvez choisir parmi de nombreuses fonctions DAX, chacune d’elles étant classée 
dans l’une des catégories suivantes: 
▪ Fonctions de Data and Time:: Les fonctions de ce type permettent de manipuler les 

valeurs de date et d'heure. En tant que telles, elles sont similaires aux fonctions de 
données et de temps pouvant être utilisées dans Excel. 

▪ Fonctions de filter:Ces fonctions permettent de manipuler et de filtrer des données de 
manière dynamique. 

▪ Fonctions d'information: Ce type de fonction est utilisé pour analyser les valeurs à 
l'intérieur d'une plage de cellules et les faire correspondre à un type de données 
attendu. 

▪ Fonctions logical:ces fonctions sont généralement utilisées pour valider des expressions 
et des valeurs, puis fonctionnent avec d'autres données basées sur l'évaluation. 

▪ Fonctions Math and Trigonometric: Les fonctions de ce type permettent d'effectuer des 
calculs mathématiques. 

▪ Fonctions statistical:Ces fonctions permettent de générer des données statistiques 
telles que des valeurs minimales et maximales, ainsi que des moyennes. 

▪ Fonctions Time Intelligence:Ce type de fonction est utilisé pour manipuler des données 
en utilisant des périodes. Ils peuvent être utilisés pour comparer les données d’une 
période à une autre. 
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SUJET B: Filtrer les données à l'aide de 
slicers 
Bien que les filtres classiques puissent être efficaces pour explorer vos données, ils peuvent 
rapidement devenir une corvée à gérer. Entre le fait de devoir effacer les filtres existants avant 
d'en appliquer de nouveaux et d'essayer de déterminer quelles données sont activement 
filtrées, les filtres présentent certains inconvénients. Pour vous donner plus de contrôle sur les 
capacités de filtrage, Excel fournit des trancheurs. Ces filtres faciles à utiliser peuvent être 
appliqués plusieurs fois sans que la lisibilité des données en pâtisse. Tout au long de cette sujet, 
vous apprendrez à connaître les segments et à les utiliser pour filtrer les données dans un Pivot 
Table. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ À propos des Slicer 
▪ À propos de la boîte de dialogue Insert Slicer 

 

SLICERS 

Les Slicers peuvent être d'une grande aide lorsque vous travaillez avec des données de Pivot 
Table. Si les Pivot Tables ont pour objectif principal de vous aider à analyser les informations et 
à trouver des modèles ou des tendances difficiles à repérer dans un grand volume de données 
brutes, le Slicer tool fait passer cette idée au niveau supérieur. 
 
Les Slicers peuvent être créés à partir de tout champ existant dans l'ensemble de données du 
Pivot Table. Ces Slicers peuvent ensuite être utilisés pour filtrer chaque champ par ses entrées 
uniques. Par exemple, si vous souhaitez filtrer les données de l’un des trois entrepôts dans une 
feuille de calcul faisant le suivi des stocks, un segmenteur pourra le faire facilement pour vous. 
Les Slicers peuvent également être liés à plusieurs Pivot Table. Cela se produit généralement 
lorsque vous utilisez des données transactionnelles brutes en tant qu'ensemble de données et 
qu'il existe plusieurs Pivot Table pour ces données. 
 
Les Slicers sont affichés graphiquement sous la forme d'un petit volet contenant une série de 
boutons représentant chaque valeur unique du champ auquel le Slicer est associé. Pour 
basculer entre le filtrage et le filtrage des valeurs uniques du champ, vous pouvez simplement 
cliquer sur ces boutons: 
 
Pour basculer entre le filtrage et le filtrage des valeurs unique du champ,vous pouvez 
simplement cliquer sur ces boutons: 
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Les filtres d'un Slicer qui ne sont pas appliqués apparaissent en bleu, tandis que ceux en blanc 
sont actifs. Si un bouton de filter apparaît en gris, cela indique qu'un filter déjà actif a supprimé 
les valeurs représentées par ce filter. Plusieurs filters présents dans le même slicer peuvent être 
appliqués simultanément en maintenant la touche Ctrl enfoncée et en cliquant sur chaque filter 
que vous souhaitez appliquer. De plus, le bouton Clear Filter situé dans le coin supérieur droit 
d'un segment désactive tous ses filters. 
 

LA BOÎTE DE DIALOGUE INSERT SLICERS 

Pour créer un Slicers, cliquez d'abord n'importe où dans le Pivot Table pour afficher les onglets 
Pivot Table Tools Ensuite, cliquez Insert → Slicers: 

 
 

(Vous pouvez également cliquer sur Table Tools - Design → Insert Slicer.) 
 

Cette action affichera la boîte de dialogue Insert Slicers: 
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Cette boîte de dialogue listera chaque champ du Pivot Table sous forme de case à cocher. Pour 
créer un slicer d'un champ, cochez la case correspondante. Une fois que vous avez fini de 
choisir les champs que vous souhaitez voir apparaître comme filters, cliquez sur OK pour 
appliquer vos paramètres. 
 
En revenant à la feuille de calcul, vous verrez maintenant la ou les slicer(s) placées à cet endroit: 
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SUJET C: Analyser des données avec des 
Pivot Charts 
 
Les Pivot Tables sont excellents pour analyser vos données, mais ils ne le sont pas non plus pour 
pouvoir les transmettre rapidement. Pour résoudre ce problème, les données du Pivot Tables 
peuvent être rapidement converties en graphiques, comme vous le pouvez avec des jeux de 
données standard. Au cours de cette sujet, vous apprendrez à utiliser les Pivot Charts pour 
présenter les données de Pivot Tables de manière visuelle. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ À propos des Pivot Charts 
▪ Comment créer des Pivot Charts 
▪ Comment appliquer un style à un Pivot Charts 

 

PIVOTCHARTS 

Les PivotCharts ressemblent aux graphiques normaux en ce sens qu'ils sont conçus pour 
transmettre l'analyse des données sous une forme visuelle. La principale différence est 
simplement que les Pivot Charts sont liés aux Pivot Tables, tandis que les graphiques sont liés 
aux plages de données ou aux tableaux. Malgré cette différence, les Pivot Charts et les 
graphiques normaux partagent bon nombre des mêmes fonctionnalités, telles que la mise à 
jour dynamique, un grand nombre de types de graphiques à choisir et la création facile. 
 
 

CRÉATION DE PIVOT CHARTS 

Pour insérer un Pivot Charts dans votre feuille de calcul, sélectionnez d’abord le Pivot Table 
avec lequel vous souhaitez travailler. Ensuite, cliquez sur Pivot Table Tools - Analyse → Pivot 
Charts: 
 

 
 
 
  



Excel 2016 Niveau 3 (Avancé)         76 

training@compuease.ca www.compuease.ca 613-235-6161 

Cette action affichera la boîte de dialogue Insert Chart. Tout comme lorsque vous travaillez 
avec des graphiques classiques, vous devez déterminer quel type de graphique convient le 
mieux à vos données. Pour cet exemple, le type de Clustered Column chart  a été sélectionné: 

 

 
 

Une fois que vous avez cliqué sur OK, le Pivot Chart est ajouté à la feuille de calcul en cours, 
affichant les données du Pivot Table: sélectionné: 
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APPLIQUER UN STYLE À UN PIVOT CHART 

Les styles de Pivot Chart permettent d’ajuster légèrement la disposition d’un graphique sans 
modifier le jeu de couleurs primaires. C’est excellent pour ajouter un peu de flair visuel à votre 
graphique et occasionnellement, un nouveau style de graphique peut également améliorer la 
lisibilité d’un graphique. 
 
Pour formater un Pivot Chart avec un style, commencez par sélectionner le Pivot Chart en 
question, puis cliquez sur Pivot Chart Tools  - Design. Examinez le groupe Styles de graphique et 
vous verrez une galerie de différents styles de graphique parmi lesquels vous pourrez choisir: 

 
 
Déplacez votre curseur sur ces styles de graphique et vous verrez un aperçu de l'apparence de 
ce style une fois appliqué à votre graphique. En cliquant sur un style, on l'appliquera: 

 
 
Vous pouvez également trouver ces styles en cliquant sur le bouton Chart Styles situé en haut à 
droite du graphique sélectionné: 
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Résumé 
Dans cette section, vous avez appris ce que sont les Pivot Tables et comment les utiliser au 
mieux pour répondre à de nombreux types de questions sur vos données. Vous savez 
maintenant comment insérer un Pivot Tables, ainsi que pour ajouter et supprimer des fields. De 
plus, vous pouvez générer des Pivot Charts à partir d'un Pivot Tables et utiliser des segments 
pour filtrer de manière sélective les entrées de champs uniques. 
 

Questions de révision 
 
1.Qu'est-ce que pivoter dans Excel? 
 
 
2.Qu'est-ce que des données transactionnelles? 
 
 
3.Qu'advient-il des champs glissés dans la zone Values du volet Liste des champs du Pivot 
Table? 
 
 
4.Quelle est la séquence de commande pour insérer un Pivot Chart? 
 
 
5.Que représentent les boutons d'un slicer? 
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SECTION 5: 
EXPORTATION DE DONNÉES 

EXCEL 
 
 
 

Objectifs de la section 
 

Dans cette section, vous apprendrez comment: 

▪ Exporter des données Excel 

▪ Importer un fichier texte délimité 

▪ Intégrer des données Excel au Web 

▪ Créer une web query 
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SUJET A: Exporter des données Excel 
 
Bien que Microsoft Excel soit une application très populaire, tout le monde n’y a pas accès. Si 
vous êtes dans une situation où vous devez envoyer des données Excel à quelqu'un et que vous 
ne savez pas s'il a accès à Microsoft Excel, vous pouvez exporter les données dans un format 
plus universel. Au cours de cette rubrique, vous apprendrez à exporter des données Excel dans 
différents formats de fichier et à partager des classeurs avec d'autres utilisateurs. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 

• A propos de l'exportation de données Excel 
 

LE PROCESSUS D'EXPORTATION 

L'exportation à partir de Microsoft Excel 2016 vous permet d'envoyer vos données Excel d'une 
application à une autre. Par exemple, vous pouvez exporter des données Excel d'un classeur au 
format texte brut afin de pouvoir les ouvrir dans n'importe quel éditeur de texte. 
 
Il existe de nombreux types de fichiers dans lesquels vous pouvez exporter des données Excel. 
Ci-dessous, nous avons présenté les options les plus courantes. 

XML Extensible Markup Language XML est utilisé pour de 
nombreuses applications Web. 

HTML Les fichiers  (Hypertext Markup Language) HTML peuvent 
être visualisés dans un navigateur Web et se trouvent 
souvent sur Internet. 

TXT Cette option vous permet d’enregistrer vos données sous 
forme de fichier texte délimité par des tabulations. Ce type 
de fichier peut être ouvert par différents éditeurs. Toutefois, 
gardez à l'esprit que seule la feuille de calcul active d'un 
classeur peut être exportée dans ce format. 

CSV Ce type de fichier correspond à Comma-Separated Values. Il 
est fréquemment utilisé pour déplacer des données 
tabulaires entre des applications. 
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PDF Créé par Adobe, le Portable Document Format (PDF) est un 
type de format de document couramment utilisé. Ce format 
est idéal pour visualiser ou imprimer rapidement des 
données, mais ne permet pas de le modifier. 

XPS Le format de fichier XML Paper Specification (XPS) est 
similaire au format PDF en ce qu’il est utilisé pour la 
visualisation et l’impression de documents. Il est entièrement 
pris en charge par la plupart des applications et des systèmes 
d'exploitation Microsoft. 
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SUJET B: Importer un fichier texte 
délimité 
Bien que vous puissiez exporter des données Excel dans divers formats, vous pouvez également 
les importer dans Excel. Au cours de cette rubrique, vous en apprendrez plus sur le processus 
d’importation de données. Nous allons nous concentrer sur la manière d'importer des fichiers 
texte délimités, car ils sont couramment utilisés pour transférer des données tabulaires entre 
des applications. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ À propos de l'importation de données dans Excel 2016 
▪ À propos du groupe Get External Data sous l'onglet Data. 
▪ A propos des fichiers texte délimités 
▪ A propos des différentes méthodes d'importation de fichiers texte 

 

LE PROCESSUS D'IMPORTATION 

Le processus d'ouverture de données dans une application enregistrée dans une autre 
application est appelé importation. Lorsque vous travaillez avec Excel 2016 en particulier, vous 
avez la possibilité d'importer toutes sortes de types de fichiers différents. Toutefois, les fichiers 
texte (avec l'extension .txt) sont généralement utilisés pour transférer des données entre des 
applications. 
 
Lorsque vous importez un fichier texte dans Excel, vous avez la possibilité de tout ou seulement 
une partie. Une fois le processus terminé, les données importées ressemblent à des données 
directement entrées dans Excel. 
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LE GROUPE GET EXTERNAL DATA 

Le groupe Get External Data propose des commandes permettant d’accéder à des données 
extérieures à Excel. Ces sources incluent des bases de données Microsoft Office Access, des 
pages Web, une variété de fichiers de données textuels et des bases de données externes. Vous 
pouvez également gérer des sources de données externes existantes: 
 

 
 

FICHIERS TEXTE DÉLIMITÉS 

Lorsque les données sont enregistrées en tant que texte délimité, le texte est entré avec une 
ligne égale à une ligne de texte. De plus, ces types de fichiers texte ont la particularité d'être 
également délimités (séparés) par des tabulations. Ce type de texte peut être lu par de 
nombreux programmes différents sur presque toutes les plateformes informatiques. Cette 
caractéristique rend les données très portables, ce qui signifie que les données brutes peuvent 
être utilisées presque n'importe où. 
 

MÉTHODES D'IMPORTATION DE FICHIERS TEXTE 

Les fichiers texte peuvent être importés dans Excel 2016 de deux manières. La première 
consiste à ouvrir le fichier directement dans Excel à l'aide de la commande File → Open. Vous 
pouvez également l'importer sous forme de plage de données à l'aide d'un assistant en cliquant 
sur Data → From Text. 
 
Bien que l’ouverture directe du fichier texte ne vous oblige pas à créer un lien vers le fichier 
texte, les données ne seront pas actualisées si le fichier texte est mis à jour. C’est le principal 
avantage de l’importer sous forme de plage à l’aide de l’assistant. 
  



Excel 2016 Niveau 3 (Avancé)         84 

training@compuease.ca www.compuease.ca 613-235-6161 

SUJET C: Intégrer des données Excel au 
Web 
 
L'une des fonctionnalités les plus puissantes d'Excel 2016 est la possibilité d'intégrer des 
données Excel au Web. Au lieu de devoir envoyer un fichier Excel à toute personne ayant 
besoin des données, Excel peut le convertir en une page Web. Vous pouvez ensuite publier 
cette page Web sur l'intranet de votre organisation ou sur Internet. À partir de là, toute 
personne y ayant accès pourra voir les données et même les éditer dans certaines 
circonstances. Au cours de cette rubrique, vous apprendrez à intégrer des données Excel au 
Web. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ À propos du processus de publication de fichiers 
▪ À propos de la boîte de dialogue Publish as Web Page 

 

LE PROCESSUS DE PUBLICATION DE FICHIERS 

Excel propose plusieurs options pour publier des plages, des feuilles de calcul ou des classeurs 
Excel sur une page Web. Pour appeler ce processus, cliquez sur File → Save as: 
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Ensuite, dans la boîte de dialogue Save as, cliquez sur le menu déroulant «Save as type», puis 
cliquez sur l'option Page Web ou Single File Web Page option: 
 

 
 

Quel que soit le type de fichier sélectionné, vous pouvez choisir d’enregistrer le classeur entier 
ou la sélection en cours à l’aide des boutons Save radio. Cliquez sur le bouton Publish pour 
ouvrir la boîte de dialogue Web Page  et définir les options avancées: 
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BOÎTE DE DIALOGUE PUBLISH AS WEB PAGE 

La boîte de dialogue Publish as Web Page inclut divers contrôles permettant de convertir les 
données Excel existantes en page Web: 
 

 
 
Cette page Web peut ensuite être téléchargée sur Internet, sur l'intranet de votre entreprise, 
ou même conservée sur votre propre ordinateur et ouverte via un navigateur. 
 
Vous trouverez ci-dessous un bref aperçu des différentes options disponibles dans cette boîte 
de dialogue. 

 
Le menu déroulant Choose vous permet de publier des feuilles de calcul individuelles, une 
plage de cellules sélectionnée, le classeur entier ou des éléments précédemment publiés: 
 

 
 

La zone Title vous permet de configurer le titre de la page Web que vous allez créer. Bien qu'il 
soit vide par défaut, vous pouvez personnaliser ce paramètre en cliquant sur le bouton 
Modifier. La zone de texte File name indique l'emplacement où sera enregistrée la page Web. 
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Le nom de fichier de la page est également défini ici. (L'emplacement du fichier est 
généralement le même dossier que celui dans lequel le classeur Excel d'origine est stocké, mais 
vous pouvez le modifier à l'aide du bouton Parcourir.) 
 
Lorsque la case «AutoRepublish every time this workbook is saved» est cochée, Excel 
republiera automatiquement les données Excel dans le classeur actuel en utilisant les 
paramètres indiqués ici chaque fois que le classeur est enregistré. Par défaut cette option est 
décochée: 
 

 
 

Lorsque la case "Open published web page in browser" est cochée, la page Web s'ouvrira 
automatiquement dans votre navigateur par défaut lors de sa publication. Cette option est utile 
pour garantir que le processus de publication a été exécuté correctement, mais il est désactivé 
par défaut. 
 
Cliquez sur le bouton Publish pour terminer le processus de publication de fichiers et publier les 
données Excel sur une page Web en utilisant les paramètres décrits dans cette boîte de 
dialogue: 
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SUJET D: Créer une  Web Query 
 
Dans le contexte d'Excel, une web query est utilisée pour établir un lien entre une page Web et 
un classeur Excel. C'est une fonctionnalité puissante qui vous permet de vous assurer que les 
données que vous utilisez sont toujours à jour. S'il est possible de s'assurer manuellement que 
vos données sont à jour, les web queries peuvent vous aider à gagner un temps considérable. 
Dans cette sujet, vous en apprendrez sur les web queries et sur la façon de les créer. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ À propos des web query 
▪ À propos de la boîte de dialogue New Web Query 

 

WEB QUERIES 

Lorsque vous utilisez Excel, les Web Queries peuvent être utilisées pour importer 
automatiquement des données au fur et à mesure de leur mise à jour. Ce processus garantira 
que vos données sont toujours à jour sans avoir à les mettre à jour manuellement. Les requêtes 
Web peuvent être configurées pour vous permettre de choisir les parties d'une page que vous 
souhaitez importer, telles qu'un tableau ou même plusieurs tableaux. Une fois la requête Web 
configurée, elle sera mise à jour chaque fois que les informations sur le site Web seront 
modifiées. 
 
 
Les requêtes Web sont créées en cliquant d'abord sur Data → From Web: 
 

 
 
Cette action ouvrira ensuite la boîte de dialogue New Web Query.  
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LA BOÎTE DE DIALOGUE NEW WEB QUERY 

La boîte de dialogue New Web Query vous propose toutes sortes de contrôles vous permettant 
de créer et de personnaliser une New Web Query: 
 

 
 

Voici un aperçu des commandes disponibles dans la barre d'outils supérieure: 
▪ La zone de texte Adresse est l'endroit où vous devez entrer l'URL de la page vers 

laquelle vous souhaitez que la web query pointe. (Par défaut, la page d'accueil définie 
dans Internet Explorer sera entrée.) 

▪ Le bouton Go ouvrira la page entrée dans la zone de texte Adresse. 
▪ Les boutons Back et Forward () vous permettent de naviguer vers la page précédente ou 

suivante que vous avez ouverte, exactement comme un navigateur Web classique. 

▪ Le bouton Stop ( )arrête le chargement de la page saisie, tandis que le bouton Refresh 

( )actualise la page Web actuellement affichée.  

▪ Le bouton Hide Icons/Show Icons ( )permet de basculer entre les icônes affichant les 
tableaux que vous pouvez importer. 

▪ Le bouton Save Query ( )ouvre la boîte de dialogue Save Query. Ici, vous pouvez 
définir l'emplacement et le nom de la requête et enregistrer le fichier de requête pour 
une utilisation ultérieure. 

Enfin, le bouton Options ouvre la boîte de dialogue Web Query Options. Dans cette boîte de 
dialogue, vous pouvez configurer la manière dont Excel importe les données d'une page Web. 
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La majorité de la boîte de dialogue New Web Query est occupée par la zone de page Web. C'est 
ici que la web page choisie est affichée. Les informations sur cette page sont divisées en blocs 
appelés tables. 
 

En utilisant votre curseur, vous pouvez cliquer sur les icônes de tableau jaunes ( )pour choisir 
les tableaux que vous souhaitez importer dans Excel: 
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Lorsqu'elles sont sélectionnées, ces icônes deviennent des coches bleues: 
 

 
 

Le bouton Import affiche la boîte de dialogue Import Data. C’est là que vous pouvez indiquer 
où, dans la feuille de calcul actuelle, les données importées doivent être placées: 
 

 
 

Une fois que vous avez cliqué sur OK, l'importation sera terminée. 
  



Excel 2016 Niveau 3 (Avancé)         92 

training@compuease.ca www.compuease.ca 613-235-6161 

Résumé 
Au cours de cette section, vous avez découvert les différentes manières d’exporter des données 
à partir d’Excel. Vous devriez maintenant être à l'aise avec l'exportation de votre classeur dans 
divers formats et son partage avec d'autres utilisateurs. En outre, vous devriez maintenant 
pouvoir importer des données d'un fichier texte dans un classeur. Vous devriez également être 
à l'aise pour publier des données sur une page Web et utiliser des requêtes Web. 
 

Questions de révision 
 
1.Quels sont les six principaux formats de fichiers vers lesquels vous pouvez exporter des 
données Excel? 
 
 
2.Sur quel onglet pouvez-vous trouver le groupe Obtenir des External Data? 
 
 
3.Quelle est la caractéristique principale qui sépare un fichier texte délimité d'un fichier texte 
standard? 
 
 
4.Que fait la case à cocher «Auto Republish every time this workbook is saved» dans la boîte 
de dialogue Web Page lorsque cette case est cochée? 
 
 
5.À quoi servent les web queries? 
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SECTION 6: 
AMÉLIORER LES CLASSEURS 

 
 
 
 

Objectifs de la section 
 

Dans cette section, vous apprendrez comment: 

▪ Personnaliser les classeurs 

▪ Gérer les themes 

▪ Créer et utiliser des modèles 

▪ Protéger les fichiers 

▪ Préparer un classeur pour le public 
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SUJET A: Personnaliser les classeurs 
Vos classeurs peuvent être personnalisés de différentes manières. Au cours de ce sujet, nous 
nous concentrerons sur la personnalisation en ajoutant des comments, des hyperlinks, des 
watermarks et des background pictures . 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ A propos des comments 
▪ À propos des hyperlinks 
▪ À propos des watermarks 
▪ A propos des background pictures 

 

COMMENTS 

Des notes peuvent être ajoutées à n’importe quelle feuille de calcul en ajoutant des comments. 
Généralement, ils servent à ajouter du contexte supplémentaire aux éléments d'une feuille de 
calcul pour guider les autres utilisateurs, mais ils peuvent également servir à ajouter des notes 
sur n'importe quel sujet. 
 
Pour ajouter un comments, sélectionnez d'abord la cellule à laquelle vous souhaitez ajouter le 
comments. Ensuite, cliquez sur Review → New Comment: 

 
 

Cette action créera un nouveau commentaire et un indicateur de commentaire rouge 
apparaîtra dans le coin supérieur droit de la cellule actuellement sélectionnée. Le commentaire 
sera étiqueté avec le nom de l'utilisateur actuel, mais vous pouvez le modifier en remplaçant ce 
texte si nécessaire. Pour ajouter du texte au commentaire, tapez à l'intérieur de la zone de 
texte fournie: 
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Une fois que vous avez terminé, cliquez n'importe où en dehors de la zone de comment text 
pour le masquer. cependant, l'indicateur de commentaire rouge restera visible: 

 
 

Pour afficher à nouveau le comment, cliquez pour sélectionner la cellule en question ou passez 
simplement votre curseur dessus. Pour supprimer un commentaire, sélectionnez la cellule dans 
laquelle le commentaire a été placé, puis cliquez sur Review → Delete. 
 

LES HYPERLINKS 

Hyperlinks Les Hyperlinks sont un pilier du monde informatique. Ils vous permettent de 
naviguer dans votre ordinateur, de naviguer sur Internet et d’accéder à différentes cellules d’un 
même classeur. Excel vous permet d'utiliser cette fonctionnalité pratique pour diviser de longs 
classeurs, diriger les utilisateurs vers une page Web, fournir des informations de contact et bien 
plus encore. 
 
Pour créer un Hyperlink, commencez par sélectionner la cellule dans laquelle vous souhaitez 
créer le Hyperlinks. Ensuite, cliquez Insert → Hyperlinks: 

 

 
 

Cette action affichera la boîte de dialogue Insert Hyperlink. 
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La partie gauche de la boîte de dialogue vous permet de choisir le type de lien (1) que vous 
souhaitez créer. Par défaut, l'option «Existing File or Web Page» sera sélectionnée. (Ce sera 
probablement le type de lien que vous utilisez le plus souvent.) 
 
Avec cette option, vous verrez les paramètres indiqués ci-dessus. En haut de la boîte de 
dialogue, vous pouvez définir le texte à afficher (2). Ceci est le texte qui deviendra bleu et 
contiendra le lien réel. (Par défaut, tout texte de la cellule que vous avez sélectionnée 
apparaîtra dans ce champ, mais vous pouvez le modifier si vous le souhaitez.) 
 
En dessous de ce champ, vous pouvez choisir le fichier (3) ou le site Web (4) vers lequel vous 
souhaitez créer un lien. Vous pouvez également configurer un info-bulle (5) pour le lien. 
 
Lorsque vous êtes prêt, cliquez sur OK pour enregistrer vos modifications ou sur Annuler pour 
les ignorer. Notez que le bouton OK ne sera actif que lorsque les champs «Text to display» et 
Adresse auront été remplis. 
 
Une fois que le lien hypertexte a été inséré, vous verrez qu'il apparaît en bleu et souligné. En 
cliquant sur le lien, vous l'ouvrez, mais en le maintenant enfoncé, vous sélectionnez la cellule 
qui le contient: 

 
Pour supprimer un lien, cliquez avec le bouton droit sur le lien hypertexte en question, puis 
cliquez sur Remove Hyperlink dans le menu contextuel. 
 

WATERMARKS 

Bien qu'Excel 2016 n'inclue pas de moyen direct pour créer des Watermarks, vous pouvez les 
ajouter à l'aide de WordArt. Pour ce faire, insérez d’abord WordArt en cliquant sur Insert → 
WordArt → [Style WordArt]: 
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Ensuite, tapez le texte que vous souhaitez créer le watermark et faites-le pivoter si nécessaire: 
 

 
 
Lorsque le WordArt est sélectionné, ouvrez la catégorie Remplissage et contour de texte du 
volet Format Shape et ajustez le curseur Transparence: 
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Le watermark sera maintenant prêt et vous pourrez le repositionner au besoin: 
 

 
 

BACKGROUND PICTURES 

Pour ajouter des éléments de conception à vos classeurs, vous avez la possibilité d'ajouter des 
images d'arrière-plan. Ces images apparaîtront entièrement à l'arrière-plan d'une feuille de 
calcul sans interférer avec le contenu des cellules. 
 
Pour insérer une image d’arrière-plan, cliquez sur Page Layout → Background: 
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Cette action affichera la boîte de dialogue Insert Pictures . En utilisant les options fournies ici, 
vous pouvez insérer une image résidant sur votre ordinateur ou sur votre réseau local, à partir 
d'une recherche Web ou même sur Facebook et Flickr si vous utilisez un compte Microsoft: 

 
 

Une fois que vous avez trouvé et sélectionné une image d’arrière-plan, elle sera ajoutée à la 
feuille de calcul actuelle. Notez que s'il ne couvre pas toutes les dimensions de la feuille de 
calcul, il se mettra automatiquement en mosaïque: 

 
 
Pour supprimer une image d’arrière-plan, cliquez sur Page Layout → Delete Background: 
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SUJET B: Gérer les themes 
 
Les thèmes contrôlent la plupart des aspects visuels de tout classeur et le choix du bon thème 
est important pour l'affichage de vos données. Au cours de cette sujet, vous en apprendrez 
davantage sur les thèmes dans Excel 2016 et sur la manière dont ils peuvent être modifiés et 
personnalisés. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ À propos des thèmes et comment les changer 
▪ Comment personnaliser les themes 

 

À PROPOS DES THÈMES 

Les thèmes sont une combinaison de couleurs, de polices et d'effets prédéfinis. Chaque thème 
comprend 12 couleurs, des polices de caractères pour l'en-tête et le corps du texte, ainsi que 
des couleurs et des effets pour les formes et SmartArt. 
 
Pour changer le thème d’un classeur, cliquez sur Page Layout → Themes: 
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Cela montrera une galerie de thèmes. Lorsque vous passez la souris sur chaque vignette de 
cette galerie, un aperçu est appliqué à votre classeur (s'il contient des éléments de thème tels 
que SmartArt, en-têtes ou corps de texte). Cliquez sur le nouveau thème pour l'appliquer: 
 

 
 

PERSONNALISATION DES THÈMES 

Le thème par défaut pour les nouveaux classeurs dans Microsoft Excel 2016 est Office. Vous 
pouvez personnaliser les styles proposés par ce thème ou par tout autre thème actuellement 
appliqué en choisissant de nouvelles options de style dans les commandes déroulantes 
Couleurs, Polices et Effets disponibles dans le groupe Thèmes de l'onglet Page Layout 
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SUJET C: Créer et utiliser des modèles 
Les modèles sont une excellente ressource que vous pouvez utiliser pour créer des classeurs 
beaucoup plus rapidement que de devoir en créer un à partir de rien. Au cours de cette 
rubrique, vous en apprendrez plus sur les modèles et sur la façon de les créer vous-même. 
 
Objectifs du sujet 

Dans ce sujet, vous apprendrez: 
▪ A propos des modèles 
▪ A propos des types de modèles 
▪ Comment créer un modèle 
▪ Comment modifier un modèle 

 

MODÈLES 

Un modèle est un classeur contenant des styles, des graphiques, des objets et / ou du texte 
préformatés. Son objectif est de fournir une méthode de mise en forme du contenu pour vous 
faire gagner du temps et vous aider à maintenir la cohérence de votre travail. Les modèles 
peuvent être utilisés avec des styles et des thèmes pour offrir encore plus d'options de 
personnalisation. 
Les modèles Microsoft Excel sont enregistrés en tant que fichiers .xltx. De cette façon, ils 
peuvent être réutilisés sans écraser le contenu du modèle. Vous pouvez également enregistrer 
des modèles avec des macros à l'aide de l'extension .xltm. 
 

TYPES DE MODÈLES 

Microsoft Excel 2016 comprend de nombreux modèles prédéfinis parmi lesquels vous pouvez 
choisir et qui couvrent une grande variété de besoins. Si vous ne trouvez pas initialement le 
modèle exact adapté à vos besoins, vous pourrez probablement le trouver à l’aide de la 
fonction de search. 
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Les modèles personnalisés sont ceux créés par vous-même, votre organisation ou une personne 
avec laquelle vous travaillez. Vous pouvez voir ces modèles énumérés sous l'en-tête Personnel 
de la nouvelle Window de classeur: 
 

 
 

CRÉER UN MODÈLE 

Si vous voulez créer votre propre modèle, c’est facile! Commencez par créer le classeur que 
vous souhaitez utiliser ultérieurement comme modèle: 
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Une fois que les informations pertinentes ont été placées dans le modèle, enregistrez-le en 
cliquant sur File → Save As → Browse: 

 

 
 
La boîte de dialogue Save As s'ouvrira. Tout d’abord, cliquez sur le menu déroulant «Save as 
type» et choisissez Modèle Excel: 
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Cela affichera automatiquement l’emplacement de fichier par défaut dans lequel tous vos 
modèles Microsoft Office personnalisés sont enregistrés. À ce stade, vous pouvez ensuite 
entrer un nom de fichier pour ce nouveau modèle, puis cliquer sur le bouton Save pour 
terminer le processus: 
 

 
 

L'enregistrement du fichier à l'emplacement par défaut garantira qu'il s'affiche dans la 
catégorie Personnel de la catégorie Nouveau en mode Backstage: 
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MODIFIER UN MODÈLE 

Pour modifier un modèle, cliquez sur File → Open → Browse: 
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Dans la boîte de dialogue Open, accédez à l'emplacement du fichier de modèle, sélectionnez-le 
et cliquez sur Open: 
 

 
 
(Si vous ne voyez pas votre fichier de modèle, assurez-vous que le filtre situé au-dessus du 
bouton Ouvrir est défini sur Tous les fichiers Excel.) 
 
Si vous utilisez l'Explorateur de fichiers pour ouvrir un modèle à modifier, double-cliquez sur un 
modèle pour ouvrir un nouveau classeur Excel basé sur le modèle et non sur le modèle lui-
même. Pour ouvrir le modèle à modifier, cliquez avec le bouton droit sur le fichier de modèle, 
puis cliquez sur Open: 
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Une fois qu'un fichier modèle est ouvert pour modification, la barre de titre d'Excel affiche le 
nom du modèle (et non Book1, Book2, etc.): 
 

 
 

Résumé 
Au cours de cette section, vous avez découvert différentes manières d'améliorer vos classeurs 
dans Excel 2016. Vous devez maintenant connaître les options de personnalisation disponibles, 
ainsi que la gestion des thèmes pour contrôler l'apparence de vos classeurs. . À ce stade, vous 
devez également être à l'aise pour créer et utiliser des modèles, ainsi que pour protéger vos 
classeurs contre la perte de données et les accès non autorisés. Enfin, vous savez maintenant 
comment préparer vos classeurs lorsque vous travaillez avec plusieurs audiences. 
 

Questions de révision 
 
1.Quelle est la séquence de commande pour insérer un commentaire? 
 
 
2.Quels sont les thèmes? 
 
 
3.Quels sont les deux types de modèles principaux? 
 
 
 
 
 


